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About SimaPro 
SimaPro is life cycle assessment software that helps organizations measure and analyze the 

environmental impacts of products across their entire life cycle. Built on extensive datasets and 

established scientific methods, the software provides transparent insights that support product 

development, sustainability strategy, and environmental reporting. 

Used by industry and academia in more than 90 countries, SimaPro enables advanced modeling 

and scalable environmental impact calculations across teams. With more than 35 years of 

development behind it, SimaPro is widely trusted in the global LCA community. SimaPro is part of 

the One Click LCA group. 
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Quick-start guide 

This section contains some general information about modelling in SimaPro. This, by no means, 

replaces the explanations in the next chapters. Please still follow each chapter carefully to get a 

thorough understanding of SimaPro and use this short guide as a reference. 

 

Creating a new project 
To create a new project in SimaPro: 

1. Open SimaPro 

2. Open the Professional database. The database name is found in the top left corner of the 

SimaPro window. If the database is not yet opened, go to File > Open SimaPro database 

and select the Professional database or another database you want to create the project 

in. If you do not see the database name on the ‘’Open database’’ window, you can click 

Browse and choose the right database. The default location for the SimaPro database is 

C:\Users\Public\Documents\SimaPro\Database.  

3. Once your database is opened, click New 

4. Enter the name of your project 

5. Select the libraries you want to use in your project 

6. Make sure to also select the Methods library because it is needed to calculate the impact 

assessment 

 

Opening an existing project 
You do not always need to create a new project. You can, for instance, continue working on your 

existing project. After selecting the right database you want to work in, you can simply open your 

project: 

1. Select the project you want, click Open 

2. Alternatively, select the project and press Enter and or open by double-click the project 

 

Creating a new process 
After you created a new project, you want to start entering your data and building your model. To 

create a new process: 

1. Go to Inventory > Processes 

2. Select Processes > Material 

3. Right-click under Material and choose New category. 

Alternatively, or when you are using the Demo version of SimaPro, you can also create 

the new process under the existing sub-categories (e.g. Others) directly 

4. Enter the name of your category 

5. Select the newly added category and then click New 
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6. Start with entering the name and amount of your process under the Input/output tab on 

the line under Outputs to technosphere: Products and co-products 

7. You can now fill in your process data by simply double-click or press Enter on the Add line 

button 

8. To move from one field to another under the same section (for instance, from Amount to 

Unit under the Outputs to technosphere), you can simply click the field or use the Tab key 

9. You can also add more comments under Documentation tab, parameters under 

Parameters tab, and details of the system under System description tab 

10. Once you are done with entering your data, click the disc icon on the toolbar to save your 

entry. Alternatively, you can press CTRL + S 

Mostly, we model under the Processes / Material category. However, in some cases you may also 

use the Processes / Processing category or model under Product stages. Further explanation on 

when to use what and the differences between the two is explained in Chapter 2. 

 

Selecting processes 
To easily find the required material/process from the large inventory database, determine the 

material/process type and search it accordingly under the respective categories.  

When you click on the Show as list checkbox on the right side of the process window, you will see 

the complete list of materials and processes from the libraries with background datasets that you 

have selected. You can then use the Filter on option at the top of the window to search for the 

materials/processes under different sub-categories by entering its name/other corresponding 

keywords, as seen in the image below. 

  
 

 

You can select multiple items at once in SimaPro to compare their LCA results. To do that, 

SimaPro uses the Windows conventions. Hold down CTRL + mouse click to select multiple 

individual entries and use SHIFT + mouse click to select a list of items. CTRL + A will select all 

items within the category. 
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Background data  
The following data is used as the default throughout this tutorial: 

• Library: Ecoinvent 3 – allocation, cut-off by classification – system (ecoinvent 3.12) 

• Method: ReCiPe 2016 Endpoint (H) (version 1.13) 

Normalization/Weighting set: World (2010) H/A 

 

Geography abbreviations 

Processes may be available for different geographical resolutions, whether it is national, regional, 

or global. In this tutorial, the global type market process {GLO} is used whenever possible for all 

materials and processes involved in the bike components production and during the bike life 

cycle stage. If no relevant market process is available or if there is no appropriate data for these 

materials and processes, then the data for the average of all European countries {RER} is used. 

For aluminium-data related, the {IAI} regions are used wherein IAI stands for International 

Aluminium Institute. 

 

For freight transport processes, we use the EURO5 data as the default. EURO5 refers to vehicles 

manufactured according to the 5th European Emission Standard. The European Emission 

Standard specifies the acceptable exhaust emission limits for vehicles. The unit used to represent 

freight transport is kgkm which represents the mass of one kg of goods transported over one km 

of distance. 

 

Transport formula 

The following formula is used to calculate the amount of freight transport needed 

 

𝑭𝒓𝒆𝒊𝒈𝒉𝒕 𝒕𝒓𝒂𝒏𝒔𝒑𝒐𝒓𝒕 𝒂𝒎𝒐𝒖𝒏𝒕 (𝒌𝒈𝒌𝒎)
= 𝒘𝒆𝒊𝒈𝒉𝒕 𝒐𝒇 𝒕𝒓𝒂𝒏𝒔𝒑𝒐𝒓𝒕𝒆𝒅 𝒈𝒐𝒐𝒅𝒔 (𝒌𝒈) 𝒙 𝒕𝒓𝒂𝒏𝒔𝒑𝒐𝒓𝒕 𝒅𝒊𝒔𝒕𝒂𝒏𝒄𝒆 (𝒌𝒎) 

 

However, ecoinvent also includes data on passenger transport. The amount of passenger 

transport is represented by km unit, which refers to the transport of an average number of 

passengers over one kilometer.  

Note that for passenger transport only the distance is important as input value, while for freight 

transport both distance and weight are important input values. 
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Buttons in SimaPro 
In the LCA Explorer screen, you will find some buttons in the Toolbar that will often be used 

throughout this tutorial. These are briefly mentioned below.  

 

Buttons Function name 

 

New project 

 

Open project 

 

Close project 

 

Save 

 

Network 

 

Tree 

 

Analyze 

 

Compare 

 

Uncertainty analysis 

 

Show data of all projects 

 

In the Network and Tree result window, you will find additional buttons. Only some of the 

important and commonly used buttons are listed below. For complete explanation, please refer 

to section 3.2.4. 

 

Buttons Function name 

 

Show cumulative indicator 

 

Show indicator as percentage 

 

Exclude long-term emissions 

 

Show flow indicator 
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Node cut-off 

 

Show navigator 

 

Show process or product stage, calculation details 

 

Show analysis groups 
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1  Introduction  
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1 Introduction 
1.1 The goal of the tutorial 
This tutorial aims to guide you through your first experience with SimaPro desktop by taking you 

through a series of simple examples. For the SimaPro Online Platform, separate guides are 

available on the SimaPro Help Center.  

This tutorial does not attempt to explain the theory behind LCA and all its methodological issues. 

The basic theory and main concepts behind LCA are described in a separate manual ‘Introduction 

to LCA with SimaPro’. This tutorial focuses on environmental LCA, not paying attention to social 

impact and life cycle costing. Each chapter in this tutorial starts with a summary of what you will 

learn and what you should read beforehand. For better understanding, we suggest you use this 

tutorial in complement to the SimaPro software. 

 

Following the examples in the tutorial 

You need to have a registered version of SimaPro to access all functionalities. Please note that 

some features or options may appear slightly different depending on the SimaPro version you 

are using. 

 

SimaPro 10.4 

Please note that this manual has been developed using SimaPro 10.4. If you are using another 

version of SimaPro, your results and screens may differ from what is presented here. 

 

1.2 Tutorial structure 
We have used one broad example of a road bike model throughout this tutorial to help you get 

acquainted with SimaPro. Using this example, we have also prepared similar LCA model exercises 

so that you can model LCA projects using SimaPro efficiently in the future. 

 

Important remark 

All inventory data for modelling examples in this tutorial is fictious and does not reflect any 

actual case. Therefore, results from these cases should be regarded as such. 

 

Chapter 2: SimaPro – Basic Introduction 

This chapter gives you an idea of how the SimaPro databases are designed and explains the use 

of different options and SimaPro features. In addition, you will learn how to build LCA models 

theoretically. It also serves as an introduction to Chapter 3 where you will start modeling 

yourself. 

https://support.simapro.com/s/
https://support.simapro.com/s/article/Introduction-to-LCA
https://support.simapro.com/s/article/Introduction-to-LCA
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Chapter 3: Building your first model 

This chapter will explain how to model the impacts over the life cycle of a road bike. You will first 

model the different types of frames used in a road bike and then analyze, compare, and interpret 

their impacts. We will show you an example to model one bike frame from which you will model 

the remaining frames in the form of exercises. 

Chapter 4: Building an advanced model 

You will model the different components used in a road bike, its use stage, and final disposal 

stages i.e., in short, you will be building a more advanced model of the road bike.  

Chapter 5: A parameterized bike model 

Sometimes, you have to input data assumptions for your LCA model which might/will result in 

uncertain calculations. Using the Parameters option in SimaPro, you can compare the impacts of 

different input scenarios. In this case, we will compare the impacts of different scenarios with 

respect to the inputs of the road bike LCA model. 

 

1.3 SimaPro training 
With this tutorial, you will learn how to use SimaPro by yourself. If you want to develop more 

advanced skills, we and our global partners provide dedicated SimaPro trainings. Please check 

this page for more information. Some trainings require you to first perform some of the lessons 

in this tutorial, to ensure that everyone attending the course understands the basics. This also 

allows for more time to be spent on more advanced subjects. 

  

https://simapro.com/global-partner-network/trainings/
http://www.pre-sustainability.com/training
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2  SimaPro basics 
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2 SimaPro basics 
What you will 

learn 

Get to know the structure of SimaPro databases, become familiar with the 

result screens and explore the features of SimaPro. This chapter serves as 

the basis to build your models. 

Required entry 

level 

Basic understanding of what LCA is about - this is intended to be your first 

experience with SimaPro 

Recommended 

reading 

Introduction to LCA with SimaPro, Chapters 1, 2, 3 and 4 

SimaPro license 

type 

Education/PhD/Expert/Power 

  

2.1 Building blocks of SimaPro 
A SimaPro database consists of projects, libraries, and general data as seen in Figure 2.1.  

  

Figure 2.1 Building blocks of SimaPro 

 

General data: The common supporting data for all libraries and projects are stored in the General 

data. This includes literature references, substances, units, and quantities. Each of these 

elements is explained in section 2.2.  

Libraries: Life cycle inventory (LCI) databases are stored as libraries. SimaPro includes many LCI 

databases, like the renowned ecoinvent database and the industry-specific Agri-footprint 

database. LCI databases contain information about the inputs, outputs, and emissions of 

industrial and agricultural processes. These processes can be used as background data for your 

LCA model. Further information is available in section 2.4. 

 

https://www.pre-sustainability.com/download/SimaPro8IntroductionToLCA.pdf
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Projects: Your model is saved in a project. Enter the input data for your model by creating your 

own processes (if you have detailed data) and/or by linking the processes already predefined in 

the LCI databases to your project. The projects are interlinked with the general substances and 

different libraries since they are modeled using the data from these substances and libraries. 

 

2.2  General data 
Once you start SimaPro, you will see the “General data” column below on the left (indicated with 

a green box in Figure 2.2) with different categories under it. 

 

 

Figure 2.2 LCA Explorer: General data 

 

These include: 

Literature references: Contain website links and references to the documents of the datasets 

used as part of the different Life Cycle Inventory (LCI) libraries or to your projects. 

Substances: A single list of all the substances which are linked to the various materials and 

processes in the database. 

Units: Define the conversion factors and units for the different quantities in SimaPro. 

Quantities:  Overarching the various quantities (like mass, volume, energy, etc.) to group units. 

 

2.3  Libraries 
You will see Figure 2.3 when you click on Libraries on the left column under “Goal and scope” 

after opening a project or creating a new project. These libraries contain the inventory databases 

for all the processes you can select for your model and one library project that contains all 

default methods. 
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Figure 2.3 LCA Explorer: Libraries 

 

Additional data available for SimaPro users 

Figure 2.3 provides an overview of the default libraries in the SimaPro Professional database 

(given users have a valid ecoinvent license). For a full overview of data available for SimaPro 

users, please refer to this article.   

 

2.3.1 Library design 
Any model will have four main life cycle stages associated with it as shown in Figure 2.4. 

 

Figure 2.4 Overall life cycle stages of products 

 

During these life cycle stages, background processes are also involved. Background processes are 

not the direct subject of your LCA but are necessary to model your result. For example, 

transportation- and energy- processes each cause raw material usage and emissions. The 

amounts and type of transport and energy needed for your model are foreground information, 

the processes describing transport and energy production are background processes.  

https://support.simapro.com/en/articles/504694-which-databases-data-libraries-are-included-in-simapro-craft
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The LCI libraries (inventory databases) include processes containing inputs and outputs. The 

input can come from nature as well as from other industrial processes included in the same 

library. The outputs are products, emissions to air, water and soil and also material for further 

processing (waste treatment). Figure 2.5 gives an overview of how SimaPro inventory processes 

are built. 

 

 

Figure 2.5 SimaPro inventory processes 

 

2.3.2 Library types in SimaPro 
From Figure 2.3 you can see that different libraries can be used for your project. Overall, apart 

from the one library project that contains all default methods, there are two types of libraries 

with inventory data: process data and input-output data libraries.  

The process data libraries should be used to determine the environmental impacts of products 

or processes according to their mass or other relevant quantities. For example, what is the 

environmental impact of using 1 kg of cement or 1 kWh of electricity from the grid in The 

Netherlands? 

Similarly, the input-output data libraries are used to determine the environmental impacts of 

investments or purchases you make within a sector or between different sectors. For example, 

what is the impact of buying X euros of goods from the agricultural sector in the country of 

region Y? 
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2.3.2.1 Process Databases 

Agri-footprint 

This library developed by Blonk Consultants allows you to do agricultural LCAs, provides 

information about bio-based production methods for the chemical and energy industry, and 

allows you to perform ISO-compliant LCAs. It contains thousands of products and processes 

specific to agricultural LCA: crops, products and intermediate products, feed compounds, food 

products, animal production systems, and background processes such as transport, auxiliary 

inputs for processing, and fertilizers. Most of these products have three predefined allocation 

options – mass, energy, and economic- and have entries for different locations in the world. Read 

more about the detailed list of products included in the database on the Agri-footprint website. 

Extensive documentation on the methodology and modelling principles is available. The 

description of data is also well documented. 

ecoinvent 

The ecoinvent Life Cycle Inventory (LCI) database developed by the ecoinvent center is the most 

complete and well-documented LCI database that is currently available. It consists of many 

thousands of datasets on energy supply, agriculture, transport, biofuels and biomaterials, bulk 

and specialty chemicals, construction materials, packaging materials, basic and precious metals, 

metals processing, ICT and electronics, dairy, wood, and waste treatment.  

The following ecoinvent databases are available for SimaPro: Allocation at point of substitution 

(APOS), Allocation cut-off by classification, Substitution, consequential, long-term and Allocation, 

cut-off, EN15804. For more information, see the ecoinvent system models. System and unit 

processes are available for all four modelling options.  

 

What is the difference between unit and system processes? 

The unit process contains only emissions and input of raw materials from one process step, plus 

references to inputs from other unit processes. So, for instance a unit process called 

“Steelmaking”, contains data on “transports of hot metal and other input materials to converter, 

steelmaking process and casting”. This means the unit process starts at the point where molten 

iron comes in from another process. The environmental load connected to ironmaking is 

described in a series of upstream unit processes, which you can look into. When you select this 

process, SimaPro will automatically include all these upstream processes. 

For the same steelmaking process, the system process version includes all emissions from 

mining to steelmaking as part of this one process record. You will also find that there are no links 

to other processes. A system process is the aggregated inventory result of an overall LCA on steel 

making and gives no insight into the inputs and outputs of the separate supply chain processes 

in the production system. A system process is, therefore, considered as a black box. The outcome 

of a calculated inventory of a unit process (including infrastructure processes) is identical to that 

of the system process with the same name. 

 

The main differences between unit and system processes are visible in Figure 2.6 and Table 2.1. 

http://www.agri-footprint.com/about/products-agri-footprint.html
https://blonksustainability.nl/tools/agri-footprint#methodology
https://support.ecoinvent.org/system-models
https://support.simapro.com/s/article/What-are-infrastructure-processes-and-how-to-include-or-exclude-them
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Figure 2.6 infographic on unit process (left) and system process (right). Unit process consists of large 

network for every process, while system process is aggregated data (one box per process) 

 

Table 2.1 main differences between unit and system processes 

Unit process System process 

Transparent (but big) process tree, that allows 

you to trace the contribution of all individual 

unit processes 

One aggregated process. No process tree or 

network with individual unit processes 

Contains uncertainty information, which 

allows you to run statistical analysis (Monte 

Carlo) 

No uncertainty information 

Relatively slow calculation Fast calculation 

 

Whether you use Unit processes or System processes, will not influence the final results. 

However, it is recommended to choose System processes by default as this will greatly improve 

the calculation speed in SimaPro. Additionally, using System processes is handy to deal with 

confidential data as datasets may be transformed into a single system process and all underlying 

details are removed. On the other hand, using the unit processes when analyzing provides 

insight into where a certain emission or impact upstream exactly takes place. 
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Library switch feature  

Although we recommend the use of System processes by default, your project might 

benefit from using the Unit processes, and vice versa. An easy way to switch between these two 

libraries in SimaPro is by using the library switch function. This allows you to replace all data from 

one library to another, given that processes in both libraries have the same names. To do this, go 

to the Calculation setup window. Select the library the process is now using under the Current 

library field and then click the library you want to switch to under the Replacing library field. 

This switch can not only be used to switch between System and Unit libraries, but also between 

different ecoinvent system models as long as processes have the same names in both libraries. 

 
USLCI+ 

The U.S. Life Cycle Inventory (USLCI+) database developed by the National Renewable Energy 

Laboratory (NREL) allows you to analyze the environmental impacts of a 

material/component/assembly manufactured in the USA. Read more about the plans to achieve 

the goals of the LCI Database project in U.S. Life Cycle Inventory Database Roadmap. Sometimes, 

this USLCI library in SimaPro contains dummy processes (i.e., no environmental impacts are 

associated with these processes). In that case, the LCA practitioner should use proxy data from 

other sources to bridge the gaps.  

Industry data 2.0 

This library contains more than 300 datasets collected by industry associations, Plastics Europe, 

World Steel, and ERASM (European Detergents and Surfactants Industries). These three industry 

databases contain data that is specific to each industry but are also relevant to many other 

sectors downstream. The data is provided in aggregated form (as system processes) meaning 

that unit processes are not available. PlasticsEurope contains roughly 85 system-level datasets 

including high volume, bulk polymers, some of the widely used engineering plastics and other 

common plastic conversion processes. Worldsteel contains 46 datasets related to steel products. 

ERASM includes 32 life cycle inventories for unit processes, covering 15 surfactants and 17 

precursors. Read more about the industrial associations at Plastics Europe, worldsteel and 

ERASM. 

 

2.3.2.2 Input Output Databases 
Input output databases allow you to assess the environmental impact of services and study 

consumption patterns. They are also useful for screening LCAs or to assess the importance of 

missing data. You can find out more about input output databases under Help> SimaPro 

Manuals. The following input output database is available in SimaPro by default as of version 

10.4. Please see our website for the most recent information on databases currently available for 

SimaPro. 

EU & DK Input Output Database 

The European Union and Denmark (EU & DK) input output database allows you to model the 

environmental impacts for the imported products to Denmark and produced in 27 EU countries. 

Read more about this database at EU & DK Input Output Database Manual. 

https://www.lcacommons.gov/
https://www.nrel.gov/docs/fy09osti/45153.pdf
https://plasticseurope.org/
https://worldsteel.org/
http://erasm.org/
https://support.simapro.com/en/articles/504694-which-databases-data-libraries-are-included-in-simapro-craft
https://www.pre-sustainability.com/download/manuals/DatabaseManualEU-DKIODatabase.pdf
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USEEIO  

The US Environmentally Extended Input Output (USEEIO) database enables you to model the 

environmental and economic impacts associated with the production and consumption of goods 

and services in the United States. It is based on input output tables from the Bureau of Economic 

Analysis (BEA), combined with environmental data on resource use and pollutant emissions. The 

USEEIO data library is included in SimaPro Craft and is available to all users. 

 

Editing library data 

If you want to make changes in the library data, please always first copy these library 

processes or methods to your project and then make the changes to the data accordingly in the 

copied library datasets. By doing so you keep the libraries as delivered by PRé intact and prevent 

unwanted overwriting of your adapted processes or methods when updating a library. 

 

2.4 Projects 
Your work in SimaPro will be saved in a project. When you open SimaPro, and whenever you click 

on the “Open project” icon, you will see a window like Figure 2.7 with all projects listed.  

 

Figure 2.7 Projects window 

To start a new project, select New to enter the name of your project and click OK to save it. To 

continue working on an already existing project, select a project and click on Open to continue 

building your model. Or simply double-click on a project’s name. For this tutorial, we used the 

https://simapro.com/products/useeio-database/
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“Tutorial” project, as available in the SimaPro Professional database. You could use this project 

for modelling the tutorial examples and exercises.  

 

Two types of projects 

You can notice that there are two types of projects, ‘Library Project’ and ‘Project’ in the above 

window. Please ensure that you don’t work in any standard library project available in the 

Professional database for database management reasons. Libraries consist of the background 

inventory data to be used in different projects. To make sure that you don’t work in a library 

project, you can sort the projects according to their type by clicking on the Type pane above. 

If you choose to make a new project this will by default, always be a ‘Project’. 

 

2.4.1 Goal and Scope 
Once you open a project, enter the goal and scope details of your project by selecting 

‘Description’ column on the left, just like the first step of a Life Cycle Analysis (LCA) of any system. 

You will see a window similar to the image in Figure 2.8. 

 

 

Figure 2.8 LCA Explorer: Goal and scope, Description 
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You can enter the name, date, person/persons involved, brief description of your project under 

the “Name”, “Date”, “Author” and “Comment” fields respectively. Choose the type of your LCA 

study under the “LCA type” field. A brief description of each LCA type will be visible in the drop-

down menu for the corresponding type. The “Reason”, “Commissioner”, “Interested party” and 

“Practitioner” fields won’t be required unless you are performing an LCA for specific companies. 

You do not need to fill all fields to complete this tutorial. The following description of the goal and 

the scope of an LCA is just to inform you on the standard procedures in life cycle assessment.  

 

Goal: Define the main goal of your LCA study. According to the ISO 14040 LCA standard, the 

description of the goal of an LCA study should contain the following elements: 

• The intended application of the LCA 

• The reason for carrying out the study 

• The intended audience 

• Whether the results are intended to be used to support comparative assertions intended 

to be disclosed to the public 

 

Scope: According to the ISO 14040 LCA standard the scope of an LCA study should contain the 

following elements: 

• The product system to be studied 

• The functions of the product system(s) 

• The functional unit and respective reference flow(s) 

• The system boundaries 

• Allocation procedures 

• Impact categories selected and LCIA method 

• Data requirements 

• Assumptions 

• Limitations 

• Initial data quality requirements 

• Type of critical review, if any 

• Type and format of the report required for the study 

 

Functional unit: When comparing two or more products it is essential that they can fulfill the 

same function. A measure of this function is defined as functional unit (FU). The functional unit 

consists of quantitative and qualitative elements defining the “what,” “how much,” “how long” and 

“how well”. 
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Functional unit example 

If you compare the environmental impacts of two different hand drying systems (for example, 

paper towels and electric hand dryers), then the function is drying hands. The functional unit can 

be defined in the following way: 

What Dry hands 

How much 1 pair of hands 

How long Right after drying 

How well Less than 0,1 gram of water remaining per hand 
 

 

Reference flows: The reference flows of the system you model. Mention the other systems 

which are required to fulfill the functional unit of your system under this field. 

 

Reference flows example 

If you are calculating the environmental impact of paper towels, with the functional unit being 

one pair of dry hands with less than 0.1 gram of water remaining after drying, then the 

appropriate reference flows would be two paper towels and corresponding packaging systems 

involved, dispenser, waste bin and bin liner used. Without these components, it would be 

impossible to fulfill the functional unit. 

 

Alternative scenarios: Describe the alternative scenarios you modeled with respect to your 

system life cycle. Sometimes you have to make various input data assumptions while modeling, 

which results in variable/uncertain results. Thus, you have to model alternative scenarios (using 

variable inputs) to understand the level of uncertainty associated with the results. This will be 

discussed more in detail as parameters in Chapter 5. 

 

Alternative scenarios example 

In the above reference flow example, we mentioned that two paper towels would be required for 

drying a pair of hands. But you can also model the environmental impacts of using one or three 

paper towels for drying a pair of hands as part of the alternative scenarios since the number of 

paper towels used for drying a pair of hands varies from person to person. 

 

When you click on the “Libraries” beneath Goal and scope on the left, you can see the different 

libraries containing LCI databases on the right. Section 2.4.1 includes a description of these 

libraries. You can also see a brief description of a library when you single-click on it. Select the 

appropriate libraries for your project. Please make sure to also select the ‘Methods’ library by 

default, so that you don’t experience problems while modeling the impacts of your system (which 

will be discussed in Chapter 3). 
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For this tutorial, we selected the “Ecoinvent 3 – allocation, cut-off by classification – system” and 

“Methods” library. After selecting these libraries, you will see the following window (Figure 2.9). 

 

Figure 2.9 LCA Explorer: Libraries 

 

Methods library  

Please don’t forget to select the ‘Methods’ library by default, so that you don’t experience 

problems while modelling the impacts of your system (will be discussed in Chapter 3).  

 

Multi-functionality 

Sometimes a process can result in more than one product (output) being produced i.e., co-

products. This is called a multi-functional process. It is therefore important to identify the 

environmental impact associated with multiple product outputs or functions. For example, in a 

sawmill, the logs are converted into planks, sawdust and bark (Figure 2.10). Thus, you have to 

allocate the environmental impact of the sawmill process across the products planks, sawdust 

and bark.  

 

Figure 2.10 Example of a multi-functional process 
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Allocation of a multi-functional process 

There are different types of allocation such as mass, economic, area and volume allocation. Mass 

and economic allocation are most commonly used. In mass allocation, you are allocating the 

impacts of the process according to the mass (weight) of the product and co-products. This 

means, the higher the weight of the product relative to the total weight of outputs, the higher the 

percentage of the allocated impact becomes. So, for example, when the mass of planks is 60% of 

the total weight, 30% is sawdust and 10% is bark, then the environmental impacts are allocated 

accordingly: 60% of the environmental impact to the planks, 30% to the sawdust and 10% to the 

bark. 

When the different outputs vary strongly, likely reflected by the difference in revenue per kg 

planks on one hand, and sawdust and bark on the other hand, economic allocation might be 

more appropriate. For the economic allocation, you are allocating the environmental impacts 

according to the revenue generated by the products and co-products i.e., the higher the product 

revenue, the higher the allocation percentage. So, for the above sawmill process example, you 

have to allocate the environmental impacts based on the revenue generated by the planks, 

sawdust and bark. For instance, if the planks generate 85% of the revenue, the sawdust 10% and 

the bark 5%, the environmental impacts are allocated accordingly: 85% of the environmental 

impact to the planks, 10% to the sawdust and 5% to the bark. See Table 2.2 on how to calculate 

the allocation percentage. 

 

Table 2.2 Allocation example for a multifunctional process 

Logs products Mass Economic 

 Planks 𝑀𝑎𝑠𝑠 𝑝𝑙𝑎𝑛𝑘𝑠

𝑀𝑎𝑠𝑠 𝑝𝑙𝑎𝑛𝑘𝑠 + 𝑀𝑎𝑠𝑠 𝑠𝑎𝑤𝑑𝑢𝑠𝑡 + 𝑀𝑎𝑠𝑠 𝑏𝑎𝑟𝑘
 

𝑉𝑎𝑙𝑢𝑒 𝑝𝑙𝑎𝑛𝑘𝑠

𝑉𝑎𝑙𝑢𝑒 𝑝𝑙𝑎𝑛𝑘𝑠 + 𝑉𝑎𝑙𝑢𝑒 𝑠𝑎𝑤𝑑𝑢𝑠𝑡 + 𝑉𝑎𝑙𝑢𝑒 𝑏𝑎𝑟𝑘
 

Sawdust 𝑀𝑎𝑠𝑠 𝑠𝑎𝑤𝑑𝑢𝑠𝑡

𝑀𝑎𝑠𝑠 𝑝𝑙𝑎𝑛𝑘𝑠 + 𝑀𝑎𝑠𝑠 𝑠𝑎𝑤𝑑𝑢𝑠𝑡 + 𝑀𝑎𝑠𝑠 𝑏𝑎𝑟𝑘
 

𝑉𝑎𝑙𝑢𝑒 𝑠𝑎𝑤𝑑𝑢𝑠𝑡

𝑉𝑎𝑙𝑢𝑒 𝑝𝑙𝑎𝑛𝑘𝑠 + 𝑉𝑎𝑙𝑢𝑒 𝑠𝑎𝑤𝑑𝑢𝑠𝑡 + 𝑉𝑎𝑙𝑢𝑒 𝑏𝑎𝑟𝑘
 

Bark 𝑀𝑎𝑠𝑠 𝑏𝑎𝑟𝑘

𝑀𝑎𝑠𝑠 𝑝𝑙𝑎𝑛𝑘𝑠 + 𝑀𝑎𝑠𝑠 𝑠𝑎𝑤𝑑𝑢𝑠𝑡 + 𝑀𝑎𝑠𝑠 𝑏𝑎𝑟𝑘
 

𝑉𝑎𝑙𝑢𝑒 𝑝𝑙𝑎𝑛𝑘𝑠

𝑉𝑎𝑙𝑢𝑒 𝑝𝑙𝑎𝑛𝑘𝑠 + 𝑉𝑎𝑙𝑢𝑒 𝑠𝑎𝑤𝑑𝑢𝑠𝑡 + 𝑉𝑎𝑙𝑢𝑒 𝑏𝑎𝑟𝑘
 

2.4.2 Inventory 
Under the “Inventory” section, you can enter the materials and processes (input) details for 

building your system. 

 

Market versus transformation processes in the ecoinvent library 

Since we selected the ecoinvent library for this tutorial, many of the materials/processes will have 

two categories: market and transformation. 

The market processes include transportation inputs and production inputs from several 

countries. Use the ‘market’ process {GLO} when the supplier is unknown. 
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The transformation processes include all the inputs and outputs for making a product or service, 

including the material and energy inputs, transportation of material inputs and resource 

extractions and emissions. 

 

In SimaPro, you should only use Processes and Product stages to build your model as seen in the 

highlighted category in Figure 2.11. 

 

Figure 2.11 LCA Explorer: Inventory, Processes and Product stages 

 

As illustrated in Figure 2.12, you can directly link processes to substances while in product stages, 

there is no link to nature. Waste scenarios are the exception because they only contain scenario 

information (percentages linked to waste treatment processes) – no substances. 

 

 

Figure 2.12 An overview of where you model in SimaPro.  

Two categories for modelling 

your systems inventory 
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When to use processes and product stages?  

Use processes, if you are only interested in doing cradle-to-gate modelling of your product i.e., if 

you only want to analyze the environmental impact of a product associated during its 

manufacturing. Also, you want to use the processes, if your modelled components/processes 

shall be highly interconnected and e.g. if the processes shall be used in other projects and/or 

included in new libraries. 

Use product stages, if you want to look at the environmental impact caused during the overall life 

cycle of a product (manufacturing, use and disposal), i.e. cradle-to-grave modelling. Utilize this 

also if the product involves the use of (reusable) components that are disposed differently, and 

you want to use the waste scenarios in SimaPro. 

If you want to model production waste, with the associated additional material needed and waste 

processing, you have to create a process first and link the assembly (product stage) 1-on-1 to the 

process’s product output. 

In the upcoming sections, you will learn how to build new models and enter their life cycle details 

under the processes and product stages in SimaPro. 

 

2.4.2.1 Processes 
The processes contain environmental data for many materials, energy, transport, processing and 

use processes alongside the waste scenario and waste treatment processes in SimaPro Figure 

2.12. You can also create a new process in the database or if required copy an existing one 

already in the database, edit its inputs and outputs and save it. When you click on “Processes”, 

you can see seven main categories as seen in Figure 2.13. 

 

Figure 2.13 LCA Explorer: Inventory, Processes, Processes: Material, Energy, Transport, Processing, Use, 

Waste scenario, Waste treatment 
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In addition, you can also create a new category by right-clicking on any one of these seven main 

categories and selecting New Category. Enter a name and you can save all your project processes 

here. In this tutorial, we used the material category but you can choose any sub-category to 

create your process. For this example below, we simply chose the sub-category “Animal feed” 

under “Agricultural”. In the following example, you can find the basic instruction for creating a 

new process while in Chapter 3, you will be presented with a guided example to model in 

SimaPro. 

1) Double-click on the Material category, select any sub-category and click on New on the 

right side. The following window will open where you can enter the inputs and outputs of 

a system. In the ensuing window, you can see that there are four different tabs: 

“Documentation”, “Input/output”, “Parameters” and “System” description. Select the 

Input/output tab. You will see a window like Figure 2.14. 

 

 
 

Figure 2.14 Material process (tab Input/output) 

 

Material versus Processing category in SimaPro 

Production of (intermediate) products is typically modelled under the “Material” category. Here 

you can assign a waste type to your product that will be used in the end-of-life modelling (after 

the use phase) to make sure the proper waste scenario is selected. 

Processing of materials and products is typically included in the ‘’Processing’’ category, where this 

waste type is excluded, but production waste treatment processes can be selected if relevant. 

Therefore, you can model in the ”Processing” category if you think your process doesn’t produce 

materials that need to be taken care of through the waste scenario after the use phase.  

Either way, this shouldn’t bring differences to the result for the production process. Material 

processes can refer to processing processes and vice versa. 
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2) Under “Outputs to technosphere: Products and co-products” enter the final product 

name which you want to calculate the impacts for. The default quantity is Mass, which is 

most often preferred but can be changed under the field “Quantity”. Enter its value and 

respective unit in the fields “Amount” and “Unit”. Choose the corresponding waste type 

for your new system under the field ”Waste type”. Choosing a waste type is only possible 

for the mass quantity. The field “Allocation %” field will be described in the next 

paragraph. 

3) In some cases, useful co-products are produced along with the main product or process. 

For example, a cow produces not only milk but also meat, skin and bone as marketable 

products. The environmental impact should be allocated to these different products, 

considering their quality and quantity. See how to deal with allocation in the 

‘’Multifunctionality’’ section under the Goal and Scope. 

4) Under “Outputs to technosphere: Avoided products”, avoided products can be added to 

represent situations where a process substitutes the production of another product. This 

approach in modelling accounts for the environmental benefit of displacing an alternative 

product. For example, in cow farming, manure produced by cows can be used as a 

natural fertilizer on agricultural land. If this manure replaces the use of a chemical 

fertilizer, the chemical fertilizer can be added as an avoided product. 

5) Choose the raw materials (inputs) directly obtained from natural resources/processes by 

double-clicking the Add  button under “Inputs from nature” and mentioning its amount 

and unit under their corresponding fields. Examples of raw material obtained from 

natural resources are “ Wood, unspecified, standing/m3”, “Zinc, Zn 3.1%, in mixed ore” 

and “Water, well, NL”. These raw materials are just substances in SimaPro and in 

themselves do not contain any associated human activities. These raw materials are 

characterized in the end and then contribute for example to resource use (or abiotic 

depletion) and water use. 

6) Similar to the above step, choose the materials obtained from industrial processes by 

double-clicking the line under “Inputs from technosphere: materials/fuels” or for energy 

processes under “Inputs from technosphere: electricity/heat” and mention the respective 

amount and unit required to produce the final output (material/process/product). 

7) Once you enter all these input details, select the corresponding substances released as 

emissions to “air”, “water” and “soil” by double-clicking the line under their respective 

fields. Like with raw materials these emissions are characterized in the end and then 

contribute to for example acidification, ozone depletion and toxicity. Select the final waste 

produced (if any) by double-clicking the line under the “Final waste flows” field. Under the 

“Non-material emissions” fields you can enter non-material inventory like noise. 

8) Specify the wastes that are treated in waste treatment under the “Outputs to 

technosphere: Waste treatment” field. For example, choose Coal slurry {GLO}| market for 

coal slurry | Cut-off. You can define how production wastes are handled in this field i.e., 

whether these wastes are incinerated/landfilled/recycled. 

 

Documentation 

Once you finish creating a new process, specify the characteristics of this process by clicking on 

the Documentation tab. You will see a window similar to Figure 2.15. 



  SimaPro Tutorial 

32 

 

 

 

Figure 2.15 Material process (tab Documentation) 

 

Process name in SimaPro 

Under the Documentation tab, you can enter the process name. Please note that this is only for 

your own reference and this name is not used anywhere. Processes are identified by the name 

defined under the Input/Output tab in the product section. Therefore, if you want to search for a 

certain process, you should use the product name defined in the Input/Output as the keyword. 

 

It is not required to fill in the documentation fields to make an LCA model and run the 

calculations, but we do advise to keep good track of the data you collect and enter in SimaPro. 

This will make your reporting a lot easier. 

1) Enter the name of your new material/process under the Name field 

2) Select the type of process (Unit or System process) under the Process type field. 

3) Enter the system boundaries, production volume, geography, start and end dates and 

other relevant details of your new material/process under the Comment field. 

4) Enter the data source under the Collection method field. 
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5) Enter the person/organization responsible for the data entry and generation under 

Record and Generator fields respectively. 

6) Mention the external links and other literature references you used for your model under 

the External links and Literature reference fields respectively. 

 

You can also look at the documentation of existing materials and processes in SimaPro for 

reference. 

 

Selecting status in SimaPro 

You can select different status of your processes or product stages in SimaPro. For 

processes, this can be found under the Documentation tab, while for product stages, you can 

find this in the Input/Output tab. The available statuses are: temporary, draft, to be reviewed, to 

be revised, and finished. By filling in the status, you can search for processes with a specific 

status using the “Find” (CTRL + F) function. However, it is not compulsory to do so as this field is 

merely for informational purposes and it will also not influence your results.  

 

Waste treatment 

Waste treatments document the emissions and other impacts which arise from landfilling, 

incinerating and recycling. To define this, SimaPro already has predefined waste treatments with 

data on the emissions for the different types of waste treatment. You can view the predefined 

waste treatments available for the different materials under the Inventory > Processes > Waste 

treatment and then select the corresponding waste treatment. The waste treatments are 

available according to the material type and waste destination. You can use these predefined 

waste treatments or create your own waste treatment process for the input materials. Creating a 

waste treatment process is similar to creating a new material process discussed above. You can 

also have a look at how the predefined waste treatments are modelled in SimaPro for reference. 

Waste scenario 

Waste scenarios allow you to model the end-of-life (disposal) stages for the input materials used 

in your system. The waste materials are sorted according to their type and sent for treatment. 

SimaPro already has predefined waste scenarios which you can use for your model. However, 

this waste scenario works only for the systems modelled as an assembly (see: product stages). 

The illustration of how waste treatment and waste scenario are specified in SimaPro can be seen 

in Figure 2.16.  
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Figure 2.16 A waste scenario specifies how a waste stream is split up and sent to other waste scenarios or 

waste treatments. This splitting can be specified per waste type (as seen in this figure) or material. A waste 

treatment specifies what actually happens i.e. if a material is landfilled, incinerated or recycled. 

 

Creating a new waste scenario 

1) Double-click on Waste scenario under Inventory > Processes (make sure that the box 

“show as list” is not selected) and you will see the different predefined waste scenarios in 

SimaPro. Select the corresponding waste scenario category you want to model and click 

on New on the right side. In this case, we selected the Landfill waste scenario. The 

following window will open (Figure 2.17): 

 

 

Figure 2.17 Waste scenario (tab Input/output) 

 

2) Enter the name of your waste scenario and its amount of waste input under Waste 

specification and Amount field respectively along with its corresponding Unit. 

3) If there are materials, energy or transport needed for the handling of the mixed waste 

this can be entered in the same way as under processes, at the Inputs from 

technosphere: materials/fuels and Inputs from technosphere: electricity/heat.  

4) Select the Materials and/or waste types separated from waste stream and its 

corresponding Material and/or Waste type. Enter the percentage of the material 

separated under the Percentage field. For example, 90% of glass is collected separately. 
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5) Choose what happens to the remaining percentage of waste materials (i.e., how they are 

treated) under Waste streams remaining after separation field and percentage of 

treatment under Percentage field. For example, you can state that 40% of the remaining 

waste is incinerated and 60% is landfilled. 

 

2.4.2.2 Product stages 
Under Inventory, select Product stages and click Product stages in the second column. You will 

now see the following window: 

 

 

Figure 2.18 LCA Explorer, Inventory, Product stages: Assembly, Life cycle, Disposal scenario, Disassembly, 

Reuse 

 

Figure 2.18 shows the Product stages divided into five categories: Assembly, Life cycle, Disposal 

scenario, Disassembly and Reuse. Each category allows you to enter details of the model with 

respect to its life cycle stages. You can see a brief overview of these categories below: 

Assembly: Enter the details (materials and processes) which are related to manufacturing a 

product assembled from one or more materials (cradle to gate).  

Life cycle: Enter the use stage processes of the product. It also allows you to link the waste 

disposal scenario of the product. 

Disposal scenario: Enter the product disposal details, i.e., the percentages of the product or 

subassembly being discarded (with different waste scenarios)/disassembled/reused. 

Disassembly: If the product is dismantled enter the corresponding details.  

Reuse: If the product is reused completely, enter the respective details. 

 

All these categories are explained in detail in the upcoming paragraphs. 
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Assembly 

Enter the assembly details of your model by single-click on Assembly > Others and clicking on 

New on the right side. The following window will open (Figure 2.19): 

 

 

Figure 2.19 Assembly (tab Input/output) 

 

1) In the Name field, enter the name of your model in the Input/output tab.  

2) In the Materials/Assemblies field, you can choose the materials used for assembling the 

product under study. If you are building a complex model which requires other 

assemblies to be modelled, you have to link these sub-assemblies under this field. This 

step is important, especially if each individual assembly is disposed of in a different way. 

Enter the amount of material/assembly input in the Amount field.  

3) In the Processes field, choose the processes involved in the production of the model. 

These production processes can be energy, transportation or other industrial processes. 

4) In the Comment field, enter the assembly description. You can enter the current status of 

the assembly being built under the Status field. 

5) Once you finish entering all the details, press CTRL + S or the Save icon at the top to save 

the product assembly model. 

 

Life cycle 

Enter the use stage processes of your model by clicking on Life cycle > Others and click on New 

on the right side. The following window will open (Figure 2.20): 
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Figure 2.20 Life cycle (tab Input/output) 

 

1) In the Name field, enter the name of the model for which you want to enter the use stage 

processes.  

2) In the Comment field, enter the life cycle description. 

3) Refer to the corresponding model assembly in the Assembly field and enter the number 

of model assemblies you want to calculate the impacts for under the Amount field. 

4) In the Processes field, enter the use stage processes of the model. These use stage 

processes can be energy/transportation/other industrial process based. 

5) In the Waste/Disposal scenario field, link the disposal system of your model. This will be 

discussed more in detail in the next section. 

6) In the Additional life cycles field, you can link the life cycle model of another system which 

plays a role in fulfilling the main purpose of the model that you are currently building in 

SimaPro. 

7) Save the life cycle model after entering all the details. 

 

Additional life cycle example 

If you are modelling the environmental impact of paper towels, you can link the life cycle 

model of their dispensers under the Additional life cycles field, since the dispensers are required 

for dispensing the paper towels. 

 

2.4.2.3  Modelling end of life (under Product stages) 
This section deals with the Disposal scenario, Disassembly and Reuse. Their relation is explained 

as well as the relation with the Assembly, Life cycle and Waste scenario and Waste treatment. 
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Disposal scenario 

In a Disposal scenario reuse of a total product, disassembly and waste treatment through 

scenarios can be addressed. Select Disposal scenario > Others and click on New to model the 

end-of-life scenarios for your system and the following window will open (Figure 2.21):  

 

 

 

Figure 2.21 Disposal scenario (tab Input/output) 

1) Mention the name of your disposal scenario under the Name field. 

2) In the Comment field, enter the system disposal description.  

3) In the Referring to Assembly field, double-click the line below and refer to the 

corresponding assembly for which you want to model the disposal scenario and enter the 

number of specific assemblies you’d like to model the impacts for under the Amount 

field. 

4) In the Processes field, enter the waste sorting and transport process details related to 

your assembly’s disposal. These industrial processes can be chosen from the Processes 

subcategories Energy, Transport, Processing or Use. 

5) In the Waste scenarios field, choose the scenario from the Waste scenarios subcategories 

Household, Incineration, Landfill, Municipal, Others or Recycling and enter the percentage 

that follows this scenario. 

6)  In the Disassemblies field, select New on the right side and enter the name of your 

disassembly model, click OK and mention the disassembly percentage in the percentage 

field. The newly made disassembly should be specified later. See below at Disassembly. 

7) If you reuse your system at the end of its life cycle, in the Reuses field, select New on the 

right side and enter the name of your reuse model. Next, click OK and enter the reuse 

percentage. The newly made reuse model should be specified later. See below at Reuse. 

Please note that the total percentage needs to be 100. 

8) Save this disposal scenario by pressing CTRL + S after you finish entering the details. 
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Waste scenarios versus disposal scenarios 

Waste scenarios are processes that refer to material flows, without observing any product 

characteristics. In waste scenarios, information on how the product is split up into different 

components (subassemblies) is omitted and only information of the materials in the waste 

stream is maintained.  

Disposal scenarios are product stages that refer to product flows (1 disposal scenario refers to 1 

assembly). Here the information on the way the product can be split into components 

(subassemblies) is kept, allowing you to model disassembly and (partial) reuse operations.  

 

Disassembly 

If your system is dismantled at the end of its life cycle, click on Disassembly > Others and click on 

New on the right side. You will then see a window like Figure 2.22. 

 

 

Figure 2.22 Disassembly (tab Input/output) 

 

1) Enter the name of your system disassembly model under the Name field. 

2) You can provide a description of your disassembly model in the comment field.  

3) Link to your corresponding system assembly (to be dismantled) by double-clicking the 

line in the Referring to assembly field and enter the number of dismantled system 

assemblies you wish to model the impacts for in the Amount field. 

4) Enter the processes related to the dismantling of your system in the Processes field. 

These processes can be energy/transportation/other industrial processes. Enter the 

corresponding value for the process in the Amount field with its respective units. 

5) In the Disposal scenarios field, enter the name of your assembly disposal scenario. If you 

modelled sub-assemblies in the assembly that this disassembly refers to, they will already 

be linked under the Sub-assembly field. You can enter the percentage of the sub-

assembly treated via a disposal scenario in the percentage field. An example will be 

presented in the next chapter. 
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6) Choose the waste scenario for the treatment of the remaining waste percentage of sub-

assemblies (which aren’t treated via a disposal scenario) in the “waste scenarios” field.  

7) Save this disassembly model by pressing CTRL + S after you finish entering the details. 

 

Reuse 

If your system is completely reused at the end of its life cycle, click on Reuse > Others and click on 

New on the right side (Figure 2.23). 

 

 

Figure 2.23 Reuse (tab Input/output) 

 

1) Enter the name for your system reuse model in the Name field. 

2) Link to the system assembly you want to reuse by double-clicking the line under Referring 

to assembly and mention the number of reuse system assemblies you want to model the 

impacts for in the Amount field. 

3) Enter the processes related to your system reuse in the Processes field. These processes 

can be energy/transportation/other industrial process. Mention the corresponding value 

for the process in the “Amount” field. 

4) You can provide a description of your reuse model in the comment field.  

5) Save this reuse model by pressing CTRL + S after you finish entering the details. 

 

2.4.2.4 System descriptions 
Systems description describes how a system model (i.e., a combination of unit processes) is built. 

In this tutorial, it is neither used nor needed. For example, the steel processes in the ecoinvent 

library describe the complete steel production process in a single record, while in fact the steel 

production process contains many unit processes. By presenting this data, much of the 

transparency within the processes is lost.  

System description provides background information about the way the system model was built. 

We suggest you inspect some of these system descriptions in the ecoinvent library. 
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2.4.2.5 Waste types 
The Waste types option is seen as a complete list of waste labels (under Inventory > Waste types 

option) that is added to a material/process output. As mentioned earlier in the Waste scenario 

paragraph above, the waste materials are split up into different waste types before being sent to 

treatment. A waste type is a generic term such as Glass, Newspaper, Ferro metals, etc. In SimaPro 

you can define your own waste type and specify which materials belong to a waste type. 

For instance, all steel materials will have almost similar emissions in the waste phase. By using a 

standard waste type label, we avoid the task of making specific waste scenarios for every material 

that is added to the database. As we will explain, you do not have to use the waste types if you 

consider them too coarse. You can also develop a waste scenario for a specific material.  

Waste types do not always have to be specified. Only materials that are specified in the 

description of the assembly or sub-assembly need to have a waste type. Another example is 

when a consumer disposes of a plastic bag. SimaPro needs to know that this plastic belongs to 

the waste type plastic, or more specifically, to polyethylene. SimaPro does not have to take into 

account that this material was oil before it was turned into plastic. The oil that went into the 

plastic does not need a waste type. If in doubt, always try to specify a waste type, it will never 

harm. With each calculation, SimaPro checks if materials that are used in assemblies indeed have 

a waste type. 

 

2.4.2.6 Parameters 
The Parameters option allows you to analyze and compare the impact of variable inputs in 

SimaPro. This option will be discussed in detail in Chapter 5.  

 

2.4.3 Impact assessment 
During the impact assessment step of an LCA study, all used raw materials and emissions during 

the life cycle of a product are translated to environmental impacts. To see all the different impact 

assessment methods used in SimaPro, go to Impact assessment > Methods and then double-click 

the Methods on the second column. A brief description of each method will be visible when you 

click on it. 

There are five different steps in a Life Cycle Impact Assessment (LCIA) process. These steps are: 

1) Characterization: All substances are multiplied by a factor which reflects their relative 

contribution to the environmental impact, quantifying how much impact a product or 

service has in each impact category. 

2) Damage assessment: This (optional) step defines the contributions of different impact 

categories to the endpoint impact (Damage) categories of the selected impact 

assessment method (i.e., in a more aggregated manner).  

3) Normalization: In this (optional) step, the results are compared to a reference value, like 

the average environmental impact caused by one person in one year. 

4) Weighting: This (optional) step multiplies the normalized indicators of each impact 

category with a weighting factor. Higher weighting factors can be attributed to more 
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“important” impact categories. The weighted results all have the same unit and can be 

added up to give a single score. 

5) Single score: In this step, the weighted results are aggregated into a single score, 

representing the overall environmental impact. 

Some of the impact assessment methods in SimaPro do not have normalization/weighting sets 

which makes it impossible for you to view the normalized/weighted/single score results when 

you select these methods. You can view the different normalization/weighting sets available for 

each method (visible at the lower part of the screen above the description) when you click on a 

specific method. Read more about the methods in Chapter 4 of the ‘Introduction to LCA with 

SimaPro’ and in the ‘Methods manual’. 

The Calculation setups option stores the analysis and comparison (impact assessment) 

calculations you made for your model in SimaPro. You have to give a name for the calculation 

setup and save it. It will be discussed more in detail in the upcoming chapters. 

 

2.4.4 Interpretation 
The Interpretation option allows you to formulate the final conclusions of your project and the 

text fields serve as a checklist of the issues to be addressed before completing your project. 

Document Links provides website links to read more about amongst others the ‘ecoinvent’ 

libraries, and email addresses for specific questions about amongst others the ecoinvent 

database.  

  

https://support.simapro.com/s/article/Introduction-to-LCA
https://support.simapro.com/s/article/Introduction-to-LCA
https://support.simapro.com/s/article/SimaPro-Methods-manual
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3  Building your first model 
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3 Building your first model 
What you will do Get hands-on experience in making an LCA model of different bicycle 

frames, calculate the environmental impacts and interpret the results 

Required Entry 

level 

Chapter 2 should be completed first 

Recommended 

reading 

‘Introduction to LCA with SimaPro’ Chapters 2, 3, 4 and 5 

SimaPro license 

type 

SimaPro Education/PhD/Expert/Power 

 

In this chapter, from section 3.2.2, you will start to build the LCA model for the production of 

different types of road bike frames, analyze it and compare their impacts. 

First, the road bike life cycle is presented in section 3.1. This section contains not only the 

information for modelling the frames in this chapter, but also for modelling the parts, the use 

phase and the disposal stage in Chapter 4. 

 

3.1 Overview of a road bike life cycle 

 

Figure 3.1 The life cycle of a bike 
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You can see the life cycle of a road bike in Figure 3.1. In a real-life scenario, a bike is assembled 

using a frame and different components like gears, wheels, brakes, etc. at a manufacturing plant. 

It is packed and then transported to the final users via distributor organizations. During the use 

stage, the bike needs maintenance to ensure its smooth functioning. At the end of life, the bike is 

either reused completely, dismantled with some components reused or disposed of with some 

material recycling, incineration and landfill. Based on these life cycle processes, a bike model is 

formulated below in section 3.1.1.  

 

Fictional example 

We used a fictitious example of the bike model in this tutorial since the main goal is to make you 

understand the main SimaPro features with the help of a simple yet practical example. 

 

3.1.1 The bike description 
Introduction:  As we saw above, a bike is assembled using different components and frames. 

Most of the bike frames are made of one of the following four materials:  

• Aluminium 

• Titanium 

• Carbon fiber 

• Steel 

Based on the assumption that the user would want to choose a road bike with an environmental-

friendly frame, this LCA bike project has the following goal: 

Goal: The goal (to be reached in Chapter 4) is to analyze and compare the environmental impacts 

over the entire life cycle of bike using four different frames (carbon fiber, titanium, aluminium 

and steel). 

Input data: The weights of the different bike frames are included in Table 3.1. 

 

Table 3.1 Type of frames and their weight 

Type of frame Weight (kg) 

Aluminium 1.5 

Titanium 1.36 

PAN (PolyAcryloNitrile) carbon fiber 1 

Steel 1.8 

 

The bike is assembled using the components listed in Table 3.2 and packaging in Table 3.3. These 

details are used to model the bikes in Chapter 4. 
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Table 3.2 Details of the bike components 

Type of frame Weight (g) Quantity 

Groupset (Chain, cassette, crankset, 

derailleurs, shifters and other moving parts 

of the bike) 

1676 1 

Handlebar 350 1 

Saddle 280 1 

Set of brakes 679 1 

Wheel 1400 2 

 

Each wheel weighs 1400 grams. So, the total weight of the two wheels used in the bike is 2800 

grams. The bike is packed using the material specified in Table 3.3. 

 

Table 3.3 Packaging for the bike 

Type of frame Weight (kg) Quantity 

Cardboard 3 1 

The following assumptions are made for the use and disposal stages of the bike: 

• The bike is used in the Netherlands for a total of 100,000 km over a lifetime of 15 years 

after which it is disposed.  

• The bike is assembled in a manufacturing plant and transported to the final use location 

in the Netherlands via distributors in a 4000 kg EURO5 truck over a total distance of 500 

km. For your information, “EURO5” refers to vehicles manufactured according to the 5th 

European Emission Standard. The European Emission Standard specifies the acceptable 

exhaust emission limits for vehicles. 

• During the use stage, the bike is taken to the maintenance center at least three times a 

year in a medium-sized diesel fuel-powered EURO5 car over an average distance of 10 km 

per trip (two-way). 

• At the end of its lifetime, 30% of the bikes is reused completely, 65% of the bikes is 

collected for processing and dismantled with partial reuse and the remaining 5% of the 

bikes ends up as municipal solid waste resulting in material-dependent recycling, 

incineration and landfilling. 

 

Inventory data 

The inventory data (materials and processes) for the production of different bike frames is 

mentioned in the upcoming sections of this chapter. The inventory details for the different 

components and other process details related to the bike disposal will be mentioned in Chapter 

4. 
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3.2 Modelling the bike 
In this section, you will start modelling the bike by learning to enter its goal and scope details and 

modelling the different bike frames. After opening SimaPro, and opening the standard 

(Professional) database, select the project Tutorial and click Open. After that, select the libraries 

you want to use. In this tutorial, we use ‘’Ecoinvent 3 – allocation, cut-off by classification – 

system”. Please also select the “Methods” library for this project (and also for all the LCA projects 

you do in the future using SimaPro) since you will need the methods for the impact assessment.  

 

3.2.1 Goal and scope of the bike project 
In this project, start modelling your bike by entering its basic details under Goal and Scope on the 

left column: 

By clicking on Description option, 

1) Mention your name in the Author field. Leave out the Comment field. 

2) Choose “Internal LCA” as the LCA type. 

3) Under Goal field, enter “To compare the environmental impacts of bikes using different 

frames over its entire life cycle”. 

4) Leave out the Reason, Commissioner, Interested party and Practitioner fields for this 

tutorial example. 

5) In the functional unit field, enter “Cycling 100,000 km over a lifetime of 15 years”. 

 

Functional unit of the bike 

Following the same rule as mentioned in section 2.5.1, the functional unit of a bike can be 

defined in the following way:  

What Cycling 

How far 100,000 km 

How long A lifetime of 15 years 

The functional unit in this case is: cycling 100,000 km over a lifetime of 15 years. 

 

6) In the reference flows field, enter “One frame, two wheels, one handle bar, one groupset 

(moving parts of the bike), a set of brakes, one saddle, one cardboard packaging”.  

 

Reference flow of the bike 

In accordance to the functional unit of a bike, the appropriate reference flows would be the 

amount of products needed to fulfil the functional unit. These are one frame, two wheels, one 

handlebar, one groupset (moving parts of the bike), a set of brakes, one saddle and one 

cardboard packaging.  
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7) Mention “Variable weights of bike”, “Variable types of materials” and “Variable 

transportation distances” under the Alternative scenarios field, since we plan to do a 

sensitivity analysis on these scenarios using parameters in Chapter 4. 

8) After you enter all the above details, select Libraries on the left column (if you didn’t save 

yet, you are asked to save) and select the “Ecoinvent 3 – allocation, cut-off by classification 

– system” and “Methods” library for this project (if you didn’t select them yet). The 

ecoinvent library was chosen since it is the most comprehensive one.  

 

3.2.2  Bike frame inventory data 
In this section, you are going to model the production stage impacts of the different bike frames 

(aluminium, titanium, carbon fiber and steel). Enter the frame details and save them under a new 

category. To create a new category, click on Processes, right-click Material and select New 

Category. Enter Name as “_Different types of bike frame”. By starting this name with an 

underscore it will appear on top of the list under Material. 

We will show you how to model the aluminium frame under this category as an example after 

which you will model the remaining frames as exercises under the same category. The aluminium 

frame is constructed using the following materials and processes as shown in Table 3.4.  

 

Table 3.4 Inventory data for the production of 1.5 kg of aluminium frame 

Materials input 

Data SimaPro category Amount Comment 

Aluminium, 

primary, ingot {IAI 

Area, Western and 

Central Europe} 

Processes > Materials > Metals > Non 

Ferro > Market 

1.579 kg 5% of production 

losses estimated 

Processes input 

Data SimaPro category Amount Comment 

Powder coat, 

aluminium sheet 

{GLO} 

Processes >Processing > Metals > 

Coating > Market 

0.375 m2  

Impact extrusion 

of aluminium, 3 

strokes {GLO} 

Processes > Processing > Metals > 

Chipless shaping > Market 

1.51 kg  

Welding, arc, 

aluminium {GLO} 

Processes > Processing > Metals > 

Welding >Market 

0.75 m  

Electricity, 

medium voltage, 

aluminium 

industry {IAI Area, 

Western and 

Central Europe} 

Processes > Energy > Electricity country 

mix > Medium voltage > Market 

31.5 kWh Energy use for 

bending, 

hydroforming, 

furnace, quench 

tank and 

screwing. 
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Waste treatment 

Aluminium (waste 

treatment) {GLO} 

Waste treatment > recycling > 

transformation 

0,079 kg Assuming that 

production 

losses need to be 

treated (coating 

ignored). 

 

3.2.3 Modelling the aluminium frame 
 

Modelling as process or as assembly? 

The aluminium frame could be modelled directly as an assembly in Product stages instead of in 

Processes. In this case we model the aluminium frame as a process under Material to be able to 

model production waste correctly (both additional material needed and waste processing). 

However, it is still necessary to create an assembly to use the life cycle and disposal features in 

SimaPro, such as defining waste scenarios at the end of the product life cycle,. In chapter 4, we 

will use the product stages and model the bike frame as an assembly. 

 

1) Create a new process by selecting Processes in the Inventory column on the left and then 

clicking on Processes > Material > _Different types of bike frames. Select New on the right 

and name it “Aluminium frame” in Outputs to technosphere: Products and co-products 

field. Enter its Amount as “1.5”, because the default Quantity is Mass with kg as default 

Unit. Allocation will be the default: ‘100%’, since you allocate 100% of the environmental 

impact to the only product produced: 1.5 kg aluminium frame. Choose Aluminium under 

the Waste type field, since we are modelling an aluminium frame.  

2) Under Inputs from technosphere: materials/fuels field, enter the materials and processes 

involved to produce the aluminium frame as seen in Table 3.4. Select category Material, 

sub-category Metals > Non Ferro > Market and then choose Aluminium, primary, ingot 

{IAI Area, Western and Central Europe}| market for aluminium, primary, ingot | Cut-off, S. 

Otherwise, you can also click Show as list and then filter on the correspondence keywords 

(See Figure 3.2). Once the process is selected, fill in 1.579 as the amount and kg as the 

unit. Since 1.579 kg of primary aluminium ingot is used for producing the final aluminium 

frame with a 5% production loss, you can mention this as an additional comment in the 

Comment field.  
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Figure 3.2 Filter on a material, product, or process 

 

3) Following the same step in (2), enter the processes input for powder coat, impact 

extrusion of aluminium, and welding using the data as stated in Table 3.4.  

4) Under Inputs from technosphere: electricity/heat create a new line, select category 

Energy, sub-category Electricity country mix > Medium Voltage > Market and choose 

Electricity, medium voltage, aluminium industry {IAI Area, Western and Central Europe}| 

market for electricity, medium voltage, aluminium industry | Cut-off, S and enter its 

Amount as 31.5, Unit as kWh, since ‘31.5’ kWh of electricity is used for bending, 

hydroforming, furnace, quench tank and screwing processes during the frame 

production. 

 

After all the materials and processes are entered, the window should look like Figure 3.3. 

 

 

 

Figure 3.3 Material process (tab Input/output) with materials and processes for Aluminium frame 

 

The emissions fields below (not seen in the window above) are left empty since we assume no 

specific emissions in this process. In the materials and processes we made the links to under the 

input from technosphere: materials/fuels fields emissions and waste treatment are included.  
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5) To get our mass balance right for the treatment of scrap we include under Outputs to 

technosphere: Waste treatment at the bottom of the process Aluminium (waste 

treatment) {GLO}| recycling of aluminium | Cut-off, S 0.079 kg. This Aluminium (waste 

treatment) is an empty process because of the cut-off at recycling. 

 

(The powder coat mass is ignored for this tutorial example). The bottom part of your process tab 

input/output should now look like Figure 3.4. 

 

 

Figure 3.4 Material process (tab Input/output) with Waste treatment process for Aluminium frame 

 

The systems description and documentation tabs are also left empty for simplicity reasons. The 

parameters tab will be discussed later in Chapter 4. 

 

6) Save the aluminium frame model by pressing CTRL + S. 

 

Tips for data search 

When searching for a certain material or process, use the ‘Find’ function (CTRL + F) for a 

quick overview. Enter your keyword in the ‘Text’ field, select which project or libraries you want to 

search, and click ‘Find’. A list of records that match your keywords will appear. To find out more 

about a record and its original source, either click ‘Go to’ or double-click on it.  

 

3.2.4 Analysis of the aluminium bike frame 
After you entered the inventory data for the aluminium frame and saved it, we need to calculate 

results to view the environmental impacts of the aluminium frame. To do this, click on the 

Network button or click Calculate menu at the top and then select Network or press F10 key. 

Enter the following details in the Calculation setup window:  

1) In the name field, enter “Network diagram of aluminium frame”. Leave the Comment field 

empty. 

2) Double-click the line under the Method field, choose Global on the left side and then 

select ReCiPe 2016 Endpoint (H) method. Choose World (2010) H/A below under the 

Normalization/Weighting set. This method was chosen for this tutorial since it covers a 

wide range of impact categories and includes weighting to calculate single score results.  
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Selecting default method 

You can set a method as default for your project, so you do not have to choose it every 

time you perform a calculation. To do that, go to the Impact assessment menu on the LCA 

explorer screen and click Methods. Under the Methods category, choose the corresponding 

method and click ‘’Set as Default’’. A confirmation of your choice will be displayed. 

For this tutorial, we use ReCiPe 2016 Endpoint (H)” with “World (2010) H/A” 

Normalization/Weighting set as the default method.  

 

3) Enter 1.5 kg under the Amount field for the aluminium frame, since we have to model the 

impacts for assembly of 1.5 kg of aluminium frame. 

 

The window should look like Figure 3.5 after entering all the details. 

 

 

Figure 3.5 Calculation setup for Aluminium frame 

 

Long-term emissions 

Long-term emissions are emissions that occur after more than 100 years. When they are 

assigned to specific subcategories (labeled ‘long term’), it’s possible to distinguish them from 

emissions occurring within the first 100 years. See this article for examples. 

There are two ways in which long-term emissions can influence your results. 

The first one is by not taking the inventoried long-term emissions into account. Practically that is 

a cut-off for emissions labeled as long-term. The “Exclude long-term emissions” checkbox in the 

calculation setup (see Figure 3.5) can be used for this. 

The second way, that long-term emissions can influence your results, is when the 

characterization factors in your method are different for long-term emissions. If there are no 

separate characterization factors for long-term emissions present in the method, all emissions 

will be treated equally. 

https://support.simapro.com/en/articles/504557-what-is-the-period-of-time-meant-by-long-term?
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4) Click on Calculate button at the bottom. If you did not already save this calculation setup, 

there is a pop-up asking if you want to save the calculation setup first. You will then see 

Figure 3.6. 

 
 

Figure 3.6 Analyze Aluminium frame, Network diagram 

 

Change the Network colors 

Please note that the colors of the boxes may differ on your screen. You can define your 

own color settings by right-clicking the background area and then selecting Colors. 

 

With the node cut-off percentage (Figure 3.6) you can create a view only showing the most 

contributing processes in your network. Processes that contribute less to a selected indicator 

than the specified percentage will not be shown. If you set the cut-off percentage to zero, then 

you will see all processes. 

 

Using threshold for Network or Tree in SimaPro 

The effect of using cut-off criteria can be seen in the process tree or network window in 

SimaPro. In many LCAs, process trees become large. These process trees contain many 

processes that have negligible contribution. This can be illustrated by setting the cut-off 

threshold for displaying processes in the process tree at e.g. 0.1 % of the environmental load (for 

a single score or an impact category). This way, it is much easier to see the relevant issues in the 

process tree. By default, SimaPro initially shows 12 nodes and displays the corresponding cut-off 

percentage. 
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Now we will look at some of the Network tab features. Only the important features of Network 

diagram will be discussed here. You can explore the remaining easy-to-understand features. 

 

Exploring the Network tab  

To deep dive further into how to get the most out of your results from the Network 

window, please refer to this video.  

 

Indicator type: here you can select which indicator, substance or product flow will be represented 

by the thermometers in the nodes below. In the above figure for instance, the Single score type is 

selected, which gives the single score environmental impact of the aluminium frame. If you take a 

look at the thermometers and indicator values, you can see how many points each 

material/process contributes to the aluminium frame production impact. In this case, aluminium 

primary ingot material has the largest contribution. You can also explore other options like 

Inventory, Characterization, Damage assessment, Normalization, Weighting and Single product 

flow from the drop-down box. 

 

Show cumulated indicators: This button allows you to see the flow indicator as an aggregated 

result. By default, this option is selected, allowing you to see the contributions of the different 

materials and processes to the aluminium frame (top node) production impact. You can use the 

“Show indicator as percentage” button (to show the relative contribution in percentages) only 

when this button is selected. 

 

Show flow indicator in line width: This option allows you to create a Sankey diagram. This means 

that the thickness of the flow line depends on their environmental impact (as seen in Figure 3.6). 

If you deselect this option, the flow lines will be represented by identical arrows throughout the 

network model. 

 

Navigator: This feature is used to navigate through the nodes in Tree/Network. You can zoom in 

or out and drag the blue box to determine what you want to see in your screen. Use the fit to 

page button to reset the setting and show the full Tree/Network again in your screen.  

 

Show analysis groups: For better understanding, the use of this button will be explained in 

Chapter 4. The main difference between Network and Tree view (the latter is not available in 

SimaPro Classroom and Faculty versions) is that the Tree view doesn’t use looped data whilst the 

Network view uses looped data. 

 

When you click on the Impact assessment tab, you will see Figure 3.7 which shows the 

characterization result of the production of 1.5 kg of the aluminium frame: 

https://support.simapro.com/articles/Video/The-Network-Tab-in-SimaPro
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Figure 3.7 Analyze Aluminium frame, Characterization results 

 

Network vs Tree 

When showing the data as Network, every process is only shown once while when choosing Tree, 

each process is shown with its inputs. For example, if there are two processes referring to the 

same process, it will be shown twice in Tree but only once in Network. This makes the structure 

for Tree can easily become large but easier to understand because everything is shown and vice 

versa for Network. Please keep in mind that you cannot show looped data in Tree, otherwise, the 

number of processes would become infinitely large. Showing looped data is only possible in 

Network. 

 

 

Showing the full legend and axis 

Depending on the number of items in the legend and the length of item names, you may 

notice that sometimes not all items are shown in SimaPro. You may also see that some texts on 

the axis are cropped, depending on the method used. To show the complete text, you can try to 

change the font to a smaller size via Tools > Option > Desktop > Font or simply change the 

position of the legend by right-clicking on the white space of the chart area > Edit chart 

properties > Legend > Position. Under the same right-click menu, you can also copy the chart to 

Excel to show all data. Excel will open automatically and create a new sheet that includes 2 tabs: 

one for the chart and one for the data. Please note that this feature is not available in SimaPro 

Classroom and Faculty licenses. 

 

 

Figure 3.7 shows the percentages of environmental impacts (characterized results) of the 

different materials and processes used for manufacturing the aluminium frame with respect to 
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the various midpoint impact categories. Click on the “Show table icon” if you want to see the 

different impact category values according to their corresponding units (in numbers) instead of 

percentages. The “Chart settings” icon allows you to change the colors of the graph bars, series 

and background, and it allows you to edit the legends and axes of the graph. 

 

How to interpret the characterization results? 

Simply click on the bar chart columns to see the exact percentage contribution of the different 

materials and processes to the corresponding impact category. In this figure, you can check that 

for the global warming impact, the aluminium primary ingot material causes 65.5% of its impact, 

powder coating the aluminium sheet (4.21%), the electricity usage (21.5%) and the impact 

extrusion of aluminium (8.04%). The remaining global warming impact percentage is caused due 

to welding. Similarly, you can interpret the results for the remaining impact categories. 

 

When you click on the Damage Assessment tab, you will see Figure 3.8. 

 

 

Figure 3.8 Analyze Aluminium frame, Damage assessment 

 

The damage assessment results are similar to the characterization results above but now the 

endpoint indicators (Damage to Human health, Ecosystems and Resources) of the ReCiPe impact 

assessment method are calculated. The difference is in the damage assessment, results are 

presented in a more aggregated manner. You can read more about the midpoint and endpoint 

impact categories of the ReCiPe impact assessment method and all other methods in SimaPro in 

the Methods manual. 

How to interpret the damage assessment results? 

Figure 3.8 shows that the use of the aluminium primary ingot has the largest contribution to 

human health (78.1%), ecosystems (64.6%) and resources (71.6%). When you select the Per 

impact category box, you will again see the characterization results of the aluminium frame. 

 

https://support.simapro.com/en/articles/504752-simapro-craft-methods-manual
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When you click on the Normalization tab, you will see Figure 3.9. 

 

Figure 3.9 Analyze Aluminium frame, Normalization results 

 

In this figure you can see the normalized contribution of the different materials and processes to 

the impacts of the aluminium frame production. These results express the relative contribution 

of the different materials and processes used for the aluminium frame to the average 

environmental impact of one person in the world per year, since you chose World (2010) H/A 

Normalization/Weighting set while selecting the impact assessment method.  

 

How to interpret the normalized results? 

When you click on the Show table icon at the top, you can see the normalized score of the 

materials and processes involved in the production of the aluminium frame for the various 

damage categories. See Figure 3.10. 

 

 

Figure 3.10 Analyze Aluminium frame, Normalization results (damage category, table) 
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For instance in this case, you can see that the production of the aluminium frame has an overall 

normalized score of 0.0052 for the Human health damage category, which implies that the 

environmental impact for production of 1.5 kg of the aluminium frame is equivalent to the 

human health damage impact caused by 0.0052 person per year or 0.52% of human health 

damage caused by an average person in a year on a world level. Similarly, you can interpret the 

results for the remaining damage categories or according to the specific materials/processes. 

Select the Per impact category box to see normalized scores according to the different midpoint 

impact categories. You will now see a table like Figure 3.11. 

 

 

Figure 3.11 Analyze Aluminium frame, Normalization results (impact category, table) 

 

When you click on the Weighting tab, Show chart and deselecting Per impact category again, you 

will see Figure 3.12. 
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Figure 3.12 Analyze Aluminium frame, Weighting results 

 

The figure above shows the weighted results for the production of the aluminium frame. 

Weighting multiplies the normalized results of the different midpoint impact/damage (endpoint) 

categories with a weighting factor that shows the relative importance of the impact/damage 

category.  

 

 

Weighting 

Weighting is the fourth (optional) step in the Life Cycle Impact Assessment (LCIA). It involves the 

multiplication of the normalized results of the different impact categories with a weighting factor 

which expresses the relative importance of each impact category. Weighting is considered as a 

controversial subject in LCA since in many cases, you will need to make trade-offs between 

different impact categories. Therefore, the outcome of your LCA studies can change depending 

on the weights assigned to the impact categories. More explanation about weighting can be 

found in the Introduction to LCA manual.  

 

How to interpret the weighting results? 

This is similar to interpreting the normalized scores. For instance, in this case the production of 

1.5 kg of the aluminium frame has an overall weighted score of 1.66 Pt (click on Show table icon 

at the top to see this value) which means that the production impact of 1.5 kg of the aluminium 

frame is equivalent to that of the impact caused by an average of 1.66 persons in the world per 

year. The unit used for expressing the environmental impact is Pt (Points). 

 

https://pre-sustainability.com/files/2014/05/SimaPro8IntroductionToLCA.pdf
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When you click on the Single score tab, you will see Figure 3.13. 

 

Figure 3.13 Analyze Aluminium frame, Single score results 

 

This figure shows the single score results for the production of the aluminium frame. This 

method gives the environmental impacts of the different materials and processes used for the 

aluminium frame production in a single score. 

 

How to interpret the single score results? 

It is the same as the weighting scores interpretation. In this case, the single score results are 

expressed in mPt (millipoints) which is equivalent to 1/1000th of a point. Select the Default units 

box at the top to express the results in Points (Pt). 

 

To see the environmental impacts caused by the different inventory substances for the different 

materials and processes involved in the production of the aluminium frame click on Inventory 

tab. You will see a window similar to Figure 3.14. 
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Figure 3.14 Analyze Aluminium frame, tab Inventory 

 

This inventory window has many different features. 

1) You can sort the order of the substances with a click on the Substance heading (shown in 

Figure 3.14). 

2) You can select the drop-down box of Compartment option to view the environmental 

impacts of different inventory substances according to their compartments (raw material, 

air borne emission, water borne emission, etc.). 

3) Select the Indicator drop down box to view the characterized results, the damage 

assessment, the normalized results, the weighted results or the single score. 

Select Single score before continuing. 

4) Adjust the Cut-off percentage at the top (next to Indicator drop down box), to adjust the 

number of inventory substances shown in the table. For example, if the cut-off is adjusted 

to 2%, this analysis will show all the inventory substances in the network that contribute 

more than 2% of the total environmental impact (Single score). 

 

 

Using threshold in the contribution analysis 

Using the cut-off feature in the contribution analysis gives you the relative contribution per 

process in a list of processes.  A process that is used more than once may have a small 

contribution in each instance, but the total contribution of all instances can still be significant.  

Contribution analysis shows this total contribution.  

 

Right-click on the selected values to explore more options to specify the results. 

To see the environmental impact contribution of each material/process to the production of the 

aluminium frame, click on Process contribution tab. You will see a similar window like Figure 3.15.  
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Figure 3.15 Analyze Aluminium frame, tab Process contribution 

 

Click on the Show chart icon to view these results in the form of a graph. You will see the results 

similar Figure 3.16 when single score is selected, and the cut-off is set to 2%. 

 

 

Figure 3.16 Analyze Aluminium frame, tab Process contribution (chart)  

 

From Figure 3.16, you can see that use of the aluminium primary ingot material is the main 

contributor to the environmental impact of the aluminium frame production. 

When you click on the Setup tab, on the first tab (General) you can view the impact assessment 

method and model details you entered for determining the impacts (as earlier shown in Figure 

3.5). 

The Checks tab (Figure 3.17) allows you to check which (and how many) substances in your model 

do not have a characterization factor in the used method (here: ReCiPe 2016 Endpoint (H)). 
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Figure 3.17 Analyze Aluminium frame, tab Checks - Check on missing characterization factors 

 

In this case, 991 substances are not defined. This is not unusual since we strive for inventories to 

be complete regardless of the presence of characterization factors.  

 

Flows without characterization factor 

When there is no characterization factor available in a method this can mean two things: there is 

no environmental impact of a certain substance according to that method, or there is simply no 

characterization factor determined within this method. You can assume that in the methods of 

the standard database characterization factors for the most relevant substances are included, 

but it might be good to check the list of substances not defined in used methods. If you for 

instance create a new process with an airborne emission called “CO2” this will not be 

characterized with the present methods because they refer to this substance as “Carbon 

dioxide”.  

 

The Product overview tab (Figure 3.18) gives you an overview of the library you have chosen, the 

project you are working on and the materials/processes used in your model. 

 

  

Figure 3.18 Analyze Aluminium frame, tab Product overview 
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3.3 Exercises 
This section contains exercises to let you model the rest of the frames directly in SimaPro. 

1) The functional unit of the bike model (cycling 100,000 kilometer over a lifetime of 15 

years) was chosen since we are doing a cradle-to-grave modelling of the bike. What would 

be the functional unit if you only want to model the manufacturing stage impacts (cradle-

to-gate modelling) of the bike? 

2) Model the remaining titanium, carbon fiber and steel frames similar to how we modelled 

the aluminium frame. Create a new process for these frames under “Processes> 

Material> _Different types of bike frames” category, enter the corresponding frame 

details and save them {CTRL + S} using the names “Titanium frame”, “PAN carbon fiber 

frame” and “Steel frame” respectively. Choose the waste types as “Non-Ferro”, “Others” 

and “Steel” for the titanium, PAN carbon fiber and Steel frames respectively. Similar to the 

above example, the environmental impacts of the frames are allocated to 100% of their 

mass.  

 

The titanium, carbon fiber and steel frame production inventory details are shown in 

  

Table 3.5 to Table 3.7. 

  

Table 3.5 Inventory data for the production of 1.36 kg of titanium frame 

Materials input 

Data SimaPro category Amount Comment 

Titanium {GLO} Processes > Material > Metals > Non-

Ferro > Market 

1.43 kg 5% production 

losses estimated 

Tap water {Europe 

without 

Switzerland} 

Processes > Material > Water > Drinking 

water > Market 

0.408 kg - 

Processes input 

Data SimaPro category Amount Comment 

Powder coat, 

aluminium sheet 

{GLO} 

Processes > Processing > Metals > 

Coating > Market 

0.34 m2 Aluminium 

assumed, since 

processes for 

titanium aren’t 

available. 

Welding, arc, 

aluminium {GLO} 

Processes > Processing > Metals > 

Welding > Market 

0.68 m - 

Waste treatment 

Steel and iron 

(waste treatment) 

{GLO}| recycling 

Waste treatment > Recycling > 

Transformation 

0,07 kg Steel and iron 

(this is an empty 

process) chosen 

as proxy to reach 
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input/output 

balance (coating 

ignored). 

Wastewater, 

average {Europe 

without 

Switzerland} 

Waste treatment > Waste water 

Treatment > Market 

0.408 l assuming all 

0.408 kg input 

needs to be 

treated and that 

the water is 

moderately 

polluted 

 

Table 3.6 Inventory data for the production of 1 kg of PAN carbon fiber frame 

Materials input 

Data SimaPro category Amount Comment 

Acrylonitrile-

butadiene-styrene 

copolymer {GLO} 

Processes > Material > Chemicals > 

Organic > Market 

2.25 kg - 

Dimethylacetamid

e {GLO} 

Processes > Material > Chemicals > 

Organic > Market 

0.0306 kg  

Injection moulding 

{GLO} 

Processes > Processing > Plastics > 

Market 

1 kg - 

Processes input 

Data SimaPro category Amount Comment 

Electricity, low 

voltage {GLO} 

Processes > Energy > Electricity country 

mix > Low voltage > Market 

58 kWh - 

Heat, district or 

industrial, other 

than natural gas 

{GLO} 

Processes > Energy > Heat > Others > 

Market 

237,3 MJ  

Output 

  Amount Comment 

Carbon dioxide, 

fossil 

Airborne emission 1,06 kg  

Waste asphalt 

{RoW} 

Outputs to technosphere: waste 

treatment 

0,22 Proxy for carbon 

fiber waste 
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Table 3.7 Inventory data for the production of 1.8 kg of Steel frame 

Materials input 

Data SimaPro category Amount Comment 

Chromium steel 

pipe {GLO} 

Processes > Material > Metals > Ferro > 

Market 

1.894 kg 5% production 

losses estimated 

Tap water {Europe 

without 

Switzerland} 

Processes > Material > Water > Drinking 

water > Market 

0.54 kg - 

Processes input 

Data SimaPro category Amount Comment 

Powder coat, steel 

{GLO} 

Processes > Processing > Metals > 

Coating > Market 

0.45 m2 - 

Welding, arc, steel 

{GLO} 

Processes > Processing > Metals > 

Welding > Market 

0.9 m - 

Waste treatment    

Steel and iron 

(waste treatment) 

{GLO}| recycling 

Waste treatment > Recycling > 

Transformation 

0,094 kg To reach 

input/output 

balance (coating 

ignored) 

Wastewater, 

average {Europe 

without 

Switzerland} 

Waste treatment > Waste water 

Treatment > Market 

0.54 l Assuming all 0.54 

kg input needs to 

be treated and 

that the water is 

moderately 

polluted 

 

 

3.4 Comparison of the frames 
When you finish entering all the frame details and save them, click on Compare icon at the top. 

Enter the following details in the calculation setup window which opens after clicking the 

Compare icon: 

1) Enter “Comparison of bike frames” in the Name field. Under Method, the ReCiPe impact 

assessment method is already selected by default (please refer to section 3.2.4 to see 

how to select a default method). 

2) Select the models of which you want to compare the impacts in the Product field. In this 

case, select the four frames and enter their weight and unit in the Amount and Unit fields. 

The window looks like Figure 3.19 after entering all the details. 
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Figure 3.19 Calculation setup for comparison of the four frames 

 

3) Click Calculate at the bottom. 

 

You will see a window similar to Figure 3.20 (if you have entered all the relevant frame details and 

followed the steps above) when you click on Single score on the Impact assessment tab. 

 

Figure 3.20 Comparison of the different types of bike frame impacts 

 

 

In this figure you can see that the production of an aluminium frame has the lowest impact, 

whilst the production of the titanium frame has the highest impact.  
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You can check the different options and features mentioned above for better understanding and 

interpretation of the factors influencing the impacts. You can use different impact assessment 

methods to verify your results.  
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4  Building an advanced 
model 
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4 Building an advanced model 
What you will do Model bicycle components, compare the life cycle impacts of bikes 

using different frames and interpret the results 

Required Entry level Chapter 2 and 3 should be completed first 

Recommended 

reading 

‘Introduction to LCA with SimaPro’ Chapters 2, 3, 4 and 5 

SimaPro license type SimaPro Education/PhD/Expert/Power 

Please note that the ‘Tree’ feature is not available in the Classroom 

and Faculty licenses of SimaPro 

 

In the previous chapter, you learned to model the different types of racing bike frames. In this 

chapter, you will learn to model the racing bike components and bike packaging in addition to 

the use and disposal stage processes of the bike. This will be done under the Inventory > Product 

stages category in SimaPro. 

  

4.1 Saddle sub-assembly 
In this section, we will model the saddle of the bike. We will also provide some data on the other 

components of a road bike. You can use this data to model the remaining components of the 

bike. The production details for these components are mentioned below. 

  

Objective: A saddle of weight 280 grams is to be modelled.  

Given: The inventory data to produce a saddle is presented in Table 4.1.  

 

Modelling bike components and packaging 

We model the bike components and bike packaging as an assembly (in product stages). This 

allows us to make use of waste scenarios to model the end-of-life. You can refer to section 2.5.2 

for further explanation between modelling in processes and in product stages. 

 

Table 4.1 Production details for the bike saddle (280 grams) 

Materials input 

Data SimaPro category Amount Comment 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

100 g Saddle mounting 

rails 
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Ethylene vinyl 

acetate copolymer 

{RER} 

Assemblies and materials > Material > 

Plastics > Thermoplasts > Market 

30 g Saddle cover 

Polyethylene, high 

density, granulate 

{GLO} 

Assemblies and materials > Material > 

Plastics > Thermoplasts > Market 

100 g Plastic saddle 

shell 

Polyurethane, 

flexible foam 

{RER} 

Assemblies and materials > Material > 

Plastics > Thermosets > Market 

50 g Foam 

Processes input 

Data SimaPro category Amount Comment 

Injection moulding 

{GLO} 

Processes > Processing > Plastics > 

Market 

100 g Moulding the 

plastic shell 

 

Steps: 

1) Open the existing project “Tutorial”, where you modelled the different bike frames. 

2) In Inventory on the left, select Product stages. Go to Product stages > Assembly > Others 

and click on New on the right side. Type Saddle in the name field to create a new 

assembly for the saddle. 

3) Enter the materials and process used for the assembling the saddle as listed in Table 4.1. 

4) Once you finish entering all the materials and process details, save the saddle assembly. 

The saddle assembly window will look like Figure 4.1. 

 

 

Figure 4.1 Assembly of saddle 

 

4.1.1 Exercise 
Model the remaining bike components and the bike packaging in product stages as new 

assemblies: the handlebar, groupset (chain, cassette, crankset, derailleurs, shifters, and other 

moving parts of the bike), a pair of brakes and wheels.  
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You can find the inventory details for these components in Table 4.2 to Table 4.6. Create separate 

sub-assemblies for each of these components under the product stages, name them as 

“Handlebar”, “Groupset”, “Brakes”, “Wheels”, “Packaging of the bike (cardboard)’’. Do not forget to 

save the part sub-assemblies after entering all details. 

 

Table 4.2 Inventory data for the handlebar (350 grams) 

Materials input 

Data SimaPro category Amount Comment 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

300 g Handlebar 

material  

Polyurethane, 

flexible foam 

{RER} 

Assemblies and materials > Material > 

Plastics > Thermosets > Market 

50 g Handlebar tape 

Processes input 

Data SimaPro category Amount Comment 

Section bar 

extrusion, 

aluminium {GLO} 

Processes > Processing > Metals > 

Chipless shaping > Market 

300 g Aluminium 

processing (this 

process includes 

1,3% aluminium 

input and waste 

treatment to 

compensate for 

production 

losses) 

 

Table 4.3 Inventory data for the groupset (1676 grams) 

Materials input 

Data SimaPro category Amount Comment 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

378 g Crankset 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

225 g Derailleur (back) 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

95 g Derailleur (front) 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals>Alloys>Market 

47 g Bottom bracket 
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Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

160 g Shifters 

Glass fibre 

reinforced plastic, 

polyamide, 

injection moulded 

{GLO} 

Assemblies and materials > Material > 

Plastics > Thermoplasts > Market 

30 g Bottom bracket 

Glass fibre 

reinforced plastic, 

polyamide {GLO} 

Assemblies and materials > Material > 

Plastics > Thermoplasts > Market 

40 g Shifters 

Iron-nickel-

chromium alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

294 g Cassette 

Steel, chromium 

steel 18/8 {GLO} 

Assemblies and materials > Material > 

Metals > Ferro > Market 

257 g Chain 

Steel, chromium 

steel 18/8 {GLO} 

Assemblies and materials > Material > 

Metals > Ferro > Market 

100 g Cable for shifters  

Synthetic rubber 

{GLO} 

Assemblies and materials > Material > 

Plastics > Rubber > Market 

50 g Shifters 

Processes input 

Data SimaPro category Amount Comment 

Wire drawing, 

steel {GLO} 

Processes > Processing > Metals > 

Chipless shaping >Market 

100 g For shaping the 

shifter cables 

(This process 

includes 4,3% 

production 

waste and the 

associated 

additional steel 

production and 

waste 

treatment.) 

 

Table 4.4 Inventory data for the brakes (679 grams) 

Materials input 

Data SimaPro category Amount Comment 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

379 g Brake mounts 

Synthetic rubber 

{GLO} 

Assemblies and materials > Material > 

Plastics > Rubbers > Market 

200 g Blocks (4 pieces) 
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Steel, chromium 

steel 18/8 {GLO} 

Assemblies and materials > Material > 

Metals > Ferro > Market 

100 g Brake cables  

Processes input 

Data SimaPro category Amount Comment 

Wire drawing, 

steel {GLO} 

Processes > Processing > Metals > 

Chipless shaping > Market 

100 g For shaping 

brake cables 

 

Table 4.5 Inventory data for a pair of wheels (together 2800 grams) 

Materials input 

Data Simapro category Amount Comment 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

1880 g Rim 

Aluminium, 

wrought alloy 

{GLO} 

Assemblies and materials > Material > 

Metals > Alloys > Market 

150 g Spokes 

Synthetic rubber 

{GLO} 

Assemblies and materials > Material > 

Plastics > Rubber > Market 

270 g Inner tire 

Synthetic rubber 

{GLO} 

Assemblies and materials > Material > 

Plastics > Rubber > Market 

450 g Outer tire 

Nylon 6 {RER} Assemblies and materials > Material > 

Plastics > Thermoplasts > Market 

50 g Rim type 

Processes input 

Data Simapro category Amount Comment 

Welding, arc, 

aluminium {GLO} 

Processes > Processing > Metals > 

Welding > Market 

0.10 m Welding the 

aluminium 

materials 

 

Table 4.6 Packaging for the bike (cardboard; 3 kg) 

Materials input 

Data SimaPro category Amount Comment 

Corrugated board 

box {RER} 

Assemblies and materials > Material > 

Paper + Board > Corrugated board > 

Market 

3000 g - 

 

4.2 Final bike assembly 
Once you have entered the details for all the components and saved them, you have to link these 

components with the different bike frames (which we already modelled in the last chapter) in 

order to create the final bike assembly.  
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Before we model the final bike assemblies for the bikes using different frames, we have to create 

separate assemblies for the different frames (aluminium, titanium, PAN Carbon Fiber and Steel) 

under Product stages > Assembly >Others. This way, we can link them as sub-assemblies in the 

corresponding final bike assemblies. Follow this step to create a separate assembly for the 

aluminium frame: 

 

1) Click on Product stages > Assembly > Others and click on New on the right side. Under 

Name, enter Frame aluminium and under Materials/Assemblies field, click the Add line 

and select the Aluminium frame under the corresponding Materials category on the left 

(which we modelled in Chapter 3). In this case, it was under Assemblies and materials > 

Material >_Different types of bike frames category. Under the Amount field, enter 1.5 and 

under Unit, choose kg since we modelled 1.5 kg of aluminium frame. After you enter the 

details, the window should look like in Figure 4.2. 

 

  

Figure 4.2 Assembly of frame aluminium 

Follow the same steps to create separate assemblies for the remaining frames you modelled as 

Processes and enter corresponding details. The weights of the frames already mentioned in 

Table 3.1 in Chapter 3. Don’t start the exercises unless you finish creating these assembly models 

for the remaining frames.  

The next step is then to model four separate final bike assemblies using the four different bike 

frames (aluminium, titanium, PAN carbon fiber and steel). You then link them with these frames 

and components assemblies since you have to compare the environmental impacts of the bikes 

using these four different frames. Follow these steps to model the aluminium frame final bike 

assembly: 

2) Create a new assembly in Product stages (click on Assembly > Others and click on New on 

the right side). Name it Bike Assembly (Aluminium frame). 

3) Double-click Add line under Materials/Assemblies and select the Frame Aluminium 

assembly you have modelled above (Assembly > Others > Frame Aluminium). Enter 1 as 

amount (the unit is p from ‘piece’). 
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Unit ‘’p’’ in SimaPro 

In SimaPro, with amount as quantity, the unit p is most often used as an abbreviation for ‘piece’. 

Other occurring uses in SimaPro are ‘guestnight’ (used in ecoinvent processes) and ‘person’. 

 

4) Now add another line under Materials/Assemblies, and choose the Groupset part you 

have modelled in the Assembly category. Enter 1 as amount. 

5) Follow the above step for the remaining components you modelled. The amount is the 

same for every assembly: 1 p. 

6) In the processes field, select Transport > Road > Market > Infrastructure and select Road 

vehicle factory {GLO}| market for road vehicle factory | Cut-off, S and enter the value 

9.3693E-10 as the amount. This road vehicle factory process reflects the bike assembly 

hall needed to assemble the bike. This value was obtained from the ecoinvent database 

for the average production of one bike. 

 

You will see (Figure 4.3) once you have followed the steps above. 

 

Figure 4.3 Assembly of bike (aluminium frame) 

 

4.2.1 Exercise 
Similar to the example we modelled above, create the bike assemblies for the remaining bike 

frames (Titanium, PAN carbon fiber and Steel) using the “Copy” function. To do that, click Bike 

Assembly (Aluminium Frame) model you just created under Product stages > Assembly > Others 

and select Copy on the right. Enter the name of the corresponding bike frame assembly and 

swap the aluminium frame with the corresponding bike frame (Titanium/PAN carbon fiber/Steel 

frame). Enter the names as Bike Assembly (Titanium frame), Bike Assembly (PAN carbon fiber 

frame), Bike Assembly (Steel frame) for the Titanium, PAN carbon fiber and Steel frames 

respectively. 

4.3 Use stage of the bike 
Once the production of the bikes is modelled in SimaPro, model its use stage processes under 

Product stages > Life cycle option. In this section we will explain how to model the use stage 

processes of the bike using the aluminium frame. 
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Objective: To model the use stage processes of the bike using the aluminium frame. 

Given: The modelling information (section 3.1.1), gives us the following details: 

 

• The entire lifetime of each bike for all the frames is 15 years. 

• The bike is transported 500 km from the manufacturing plant to the store location in a 

EURO5 truck. Use Transport, freight, lorry 3.5-7.5 metric ton, euro5 {RER}, market for this 

transportation process. 

• For maintenance of the bikes assume three times a year. This involves transport to the 

maintenance center in a medium-sized EURO5 diesel fueled passenger car for an average 

distance of 10 km per round trip (i.e., 30 km per year corresponding to 450 km over total 

lifetime of the bike). 

 

The total weight of each bike was calculated by adding up the weights of the components (5.785 

kg), the different frames and its packaging (3 kg). The weights of the different bike frames are 

mentioned in Table 3.1 in Chapter 3. See Table 4.7 for the total weight of the bikes, including 

packaging. 
 

Table 4.7 Total weight of the bike for different frames and including 3 kg packaging 

Type of bike frame Total bike weight (kg) 

Aluminium 10.285 

Titanium 10.145 

PAN carbon fiber 9.785 

Steel 10.585 

 

Steps: 

1) Create a new life cycle model for the bike using the aluminium frame by clicking on Life 

cycle > Others under Product stages and click on New on the right side. Name it as Bike 

life cycle (Aluminium frame) under the Name field.  

2) Double-click the line under Assembly field. Select the Bike Assembly (Aluminium frame) 

from the Assembly category and enter 1 as the amount (unit is p) since you have to 

model the use-stage impact for one piece of aluminium bike. 

3) Enter the bike transportation details from the manufacturing to use location. To do this, 

double-click the line below Processes field, click on category Transport > Road > Market 

and then choose Transport, freight, lorry 3.5-7.5 metric ton, euro5 {RER}| market for 

transport, freight, lorry 3.5-7.5 metric ton, EURO5 | Cut-off, S, since we assume this truck 

type is used to transport the bike from the manufacturing to use location. Using the 

formula in the Background data for freight transport, the transport needed to transport 

10.285 kg of bike over 500 km distance is 5142.5 kgkm. Thus, enter 5142.5 as amount and 

select kgkm as unit.  

4) In a new line, enter the transportation values involved for the bike maintenance 

(transportation to the maintenance center).  

Since a medium-sized diesel fuel powered EURO5 car is used for taking the bike to the 

maintenance center, double-click Processes field, double-click category Transport >  Road 



  SimaPro Tutorial 

78 

 

> Market and then choose Transport, passenger car, medium size, diesel, EURO 5 {GLO}| 

market for transport, passenger car, medium size, diesel, EURO 5 | Cut-off, S, and enter 

the Amount as 450 with its unit as km, since that is the total distance travelled to the 

maintenance center over the entire bike lifetime. 

5) Under Waste/Disposal scenario, double-click the line, click on New on the right side in the 

ensuing window and enter Name as “Disposal of bike (aluminium frame)”. We will see 

how to enter details for this disposal scenario in the next section. 

6) Save the life cycle model. 

After all these details are entered, the window will look like Figure 4.4. 

 

Figure 4.4 Lifecycle of bike (aluminium frame) 

 

4.3.1 Exercise 
Similar to the example above, model the use stage impacts for the remaining bike frames 

titanium, carbon fiber, and steel and save them under the names Bike life cycle (Titanium frame), 

Bike life cycle (Carbon fiber frame), Bike life cycle (Steel frame) respectively. The transportation 

details for the bikes using these frames is similar to the bike using aluminium frame as well. The 

total weights of the bikes using different frames can be found in Table 4.7. Under Waste/Disposal 

scenario, create disposal scenarios for these frames and name them as Disposal of bike (titanium 

frame), Disposal of bike (PAN carbon fiber frame), Disposal of bike (steel frame) for the titanium, 

PAN carbon fiber and Steel frames respectively as we did for the aluminium frame bike. 

 

4.4 Disposal of the bike 
Enter the disposal details of the bike after entering its production and use stage processes under 

Product stages > Disposal scenario > Others category. Similar to the pattern followed above, we 

will explain how to model the disposal process of the bikes using aluminium frames. From this 

you will model the disposal processes for the remaining bike frames as part of the exercises.  

Objective:  To model the disposal stage of the bike using aluminium frame. 

Given:  We assume (from section 3.1.1) for the bike’s end of life that: 

• 30% is reused completely 
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• 65% is collected as bulky waste for further processing, with some components being 

reused 

• 5% ends up directly as municipal solid waste 

 

Assumptions:  We make the following additional assumptions with respect to the different types 

of bike disposal: 

• The 30% of the bikes that will be reused are transported in a EURO 5 truck over a 

distance of 2000 km in order to reuse it in a different country. 

• The 65% bikes collected as bulky waste for processing, are transported to a waste 

management service company over a distance of 200 km in a EURO5 truck. Use Market 

type {RER} for this transportation process. At the waste management service company 

the bike is disassembled.  

o A part of the different bike frames and components will be disassembled for 

reuse. The disassembly percentages and the actual reuse percentages (%) thereof 

are mentioned in Table 4.8. 

o The remaining percentage per component is assumed to be treated as municipal 

solid waste in the Netherlands through “Municipal solid waste (waste scenario) 

{NL}| Treatment of waste | Cut-off, S”, which entails different percentages per 

material/waste type separated from the waste stream for material recycling. Take 

a look at this process in SimaPro (Processes > Waste scenario > Municipal > 

Municipal solid waste (waste scenario) {NL}| Treatment of waste | Cut-off, S) for 

details (Figure 4.5). 

 

 
Figure 4.5 Municipal solid waste process in SimaPro 
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Table 4.8 Disassembly and Reuse percentages of different bike components collected as bulky waste 

Components Disassembly 

percentage (%) 

Names of the disposal 

scenarios for components 

Reuse 

percentage (%) 

Aluminium frame 50 Disposal of aluminium frame 20 

Titanium frame 50 Disposal of titanium frame 20 

Carbon fiber frame 50 Disposal of carbon fiber frame 20 

Steel frame 50 Disposal of steel frame 20 

Saddle 40 Disposal of the saddle 25 

Handlebar 30 Disposal of handlebar 5 

Groupset 0 Disposal of groupset 0 

Wheels 35 Disposal of the wheels 25 

Set of brakes 0 Disposal of the brakes 0 

Cardboard packaging 0 Packaging disposal of the bike 0 

 

• The 5% that ends up as municipal solid waste is assumed to be treated as municipal solid 

waste in the Netherlands through “Municipal solid waste (waste scenario) {NL}| 

Treatment of waste | Cut-off, S”. 

 

Steps: 

1) You have already created a disposal scenario for the bike with the aluminium frame in the 

previous section. You can find it under Product stages > Disposal scenario > Others and 

select Disposal of bike (aluminium frame). Now enter the corresponding details under this 

model by following the next few steps. 

 

Referring to Assembly field 

The corresponding bike assembly ‘Bike Assembly (Aluminium Frame)’ is already linked under the 

Referring to assembly field for this disposal scenario. 

 

2) Leave the Processes field empty since there is no separate waste associated with the bike 

except for its packaging which is assumed to be separated by the consumer itself. 

3) Since 5% of the bikes after its lifetime directly ends up as municipal solid waste in the 

Netherlands, double-click the line under Waste scenarios field, select Municipal category 

and then select “Municipal solid waste (waste scenario) {NL}| Treatment of waste | Cut-

off, S” and enter 5% in the percentage field. 

4) Since 65% of the bikes are collected for processing, double-click the line under 

Disassemblies field and create a new disassembly model for the bike using aluminium 

frame. Click New on the right side and enter the name of your model as ‘Disassembly of 

bike (aluminium frame)’ and click OK. In the percentage field, enter 65%. 

5) Since 30% of the bikes are assumed to be reused, double-click the line under Reuses field 

and similar to the above step, create a reuse model for the bike using aluminium frame. 

Click New on the right side and enter the name of your model as ‘Reuse of bike 

(aluminium frame)’ and click OK. In the percentage field, enter 30%.  

6) Save this disposal scenario. 
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After all the details are entered the disposal scenario window will look like Figure 4.6. 

 

Figure 4.6 Disposal scenario of bike (aluminium frame) 

4.4.1 Exercise 
Enter the details for the corresponding disposal scenarios of the bikes using “Titanium”, “PAN 

carbon fiber” and “Steel” frames. You already created the (still empty) disposal scenarios for these 

bike frames in the previous exercise in section 4.3.1. 

 

4.5 Disassembly 
In the previous step, you created a new disassembly for the bike with aluminium frame named as 

Disassembly of bike (aluminium frame). You can find this disassembly by clicking on Disassembly 

> Others under Product stages. This disassembly is empty, and it needs to be filled. Enter the 

relevant details for this disassembly by following these steps: 

 

Referring to assembly field 

The corresponding bike assembly ‘Bike Assembly (Aluminium Frame)’ is already linked under the 

Referring to assembly field for this disassembly. 

 

1) Under Processes field, enter the transportation details involved with the respect to the 

dismantling of the bike: Double-click the line below Processes field, click category 

Transport > Road > Market and then choose Transport, freight, lorry 3.5-7.5 metric ton, 

euro5 {RER}| market for transport, freight, lorry 3.5-7.5 metric ton, EURO5 | Cut-off, S, 

assuming that this type of truck is used to transport the bike to the waste service 

company for disassembling it. The amount is 1457 kgkm.  

2) Create disposal scenarios for the disposal of an aluminium frame and the components 

used for assembling the Bike Assembly (Aluminium Frame) by double-clicking the empty 
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line next to each correspondence sub-assembly. Click on New on the right side. In the 

ensuing window, enter the names of the disposal scenarios for the aluminium frame and 

the different components as mentioned in Table 4.8 above. You can skip the groupset, set 

of brakes and cardboard packaging since we assume that they are not separated as sub-

assemblies but are directly treated as municipal solid waste. 

 

 

Separation of sub-assemblies field 

The sub-assemblies used for this disassembly will already be linked under the Sub-assembly 

field. 

 

3) Enter the disassembly percentages of the bike frame and other components from Table 

4.8 in the Percentage field.  

4) In the Waste scenarios field, Select Municipal category and then choose “Municipal solid 

waste (waste scenario) {NL}| Treatment of waste” and then enter 100% under the 

Percentage field, since the components which aren’t separated are assumed to be 

processed as municipal solid waste in the Netherlands. The Waste scenarios field should 

always be equal to 100%. If not equal to 100%, SimaPro will show an error, since these 

remaining components have to be disposed of completely. 

After all the details are entered, the disassembly model window will look similar to Figure 4.7. 

 

Figure 4.7 Disassembly scenario of bike (aluminium frame) 

Note that the “Set of brakes”, ‘’Groupset’’ and “Packaging of the bike (cardboard)” sub-assemblies 

are visible in this disassembly. Because the associated percentages are 0 it is fine to leave the 

disposal scenario empty. Alternatively you might want to give these disposal scenarios a name. 

By doing so (empty) scenarios are created but it will not be used because of the percentage being 

0. 
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4.5.1 Components disposal scenario’s 
In the previous section, we created disposal scenarios for the frames and bike components. You 

can find these models by double-clicking on Disposal scenario > Others under Product stages. 

These disposal scenarios are still empty. We already mentioned (under section 4.4) that the 

separated bike frames and components are partly reused. Follow the steps below to enter the 

disposal scenarios of the different frames and components concerned. In this case, we enter the 

details for the Disposal of aluminium frame model: 

1) Select Product stages > Disposal scenario > Others to the left and select ‘Disposal of 

frame aluminium’ model on the right.  

2) In this disposal scenario, under Waste scenarios field, double-click the line and select 

“Municipal solid waste (waste scenario) {NL}| Treatment of waste | Cut-off, S” and enter 

80% under Percentage, since 80% of the frames are assumed to be discarded as 

municipal solid waste.  

3) Under the Reuses field, double-click Add line and select New. Give this reuse product 

stage a name like “Reuse of frame (aluminium)”. Enter 20% under Percentage. The 

window now looks like Figure 4.8: 

 

Figure 4.8 Disposal scenario of aluminium frame 

4) Save this Disposal of frame aluminium model.  

Do not forget to enter the details for the remaining bike components (saddle, handlebar, set of 

wheels) disposal scenarios using the reuse percentages as stated in Table 4.8 before you start 

solving 4.5.2 Exercise.  

 

4.5.2 Exercise 
Create disassembly models for the bikes using Titanium, PAN carbon fiber and Steel frames 

similar to how we built the disassembly model for the bike using Aluminium frame as above. 

Name them as Disassembly of bike (Titanium frame), Disassembly of bike (PAN carbon fiber 

frame) and Disassembly of bike (Steel frame) respectively. Create disposal scenarios for the 

corresponding frames (as we did for the aluminium frame above) and enter the corresponding 

details. Link the already created disposal scenarios for the components (under the Disposal 
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scenarios field) to the respective Disassembly models of bikes using Titanium, PAN carbon fiber 

and Steel frames. 

 

4.6 Reuse 
While creating the bike disposal scenario (section 4.4), we already built a reuse model “Reuse of 

bike (aluminium frame)” for the bike using aluminium frame. This model is empty now. You can 

find this model by double-clicking on Product stages > Reuse > Others. Enter the relevant details 

under this model by following these steps: 

 

Referring to assembly field 

Similar to the disassembly model, the corresponding bike assembly ‘Bike Assembly (Aluminium 

Frame)’ is already linked under the Referring to assembly field for this reuse model. 

 

1) Under Processes field, enter the transportation details involved for the bike reuse: 

Double-click the line below Processes field, double-click category Transport > Road >  

Market and then choose Transport, freight, lorry 7.5-16 metric ton, euro5 {RER}| market 

for transport, freight, lorry 7.5-16 metric ton, EURO5 | Cut-off, S, since we assume this 

type of truck is used to transport the bike to its reuse location. Enter the transportation 

Amount as 14570, Unit as kgkm.  

2) Save this reuse model. 

 

After entering all these details, the reuse model window looks like Figure 4.9. 

 

Figure 4.9 Reuse scenario of bike (aluminium frame) 

 

4.6.1 Exercise 
Enter the details for the reuse models of the bikes using Titanium, PAN carbon fiber and Steel 

frames similar to how we entered the details for the Reuse of bike (aluminium frame) model 

above. 
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4.7 Environmental impacts of aluminium frame bike life cycle 

4.7.1 Network and Tree diagram 
To get an overview of the whole model you have just built, click on the Bike life cycle (Aluminium 

frame) (under the Product stages > Life cycle > Others) and choose the Network icon at the 

toolbar. If you didn’t yet select a default method, choose ReCiPe 2016 Endpoint (H) impact 

assessment with World (2010) H/A Normalization/Weighting set as the method and click 

Calculate. You will get a warning: “Not all products of this network are currently visible (12 of 66).” 

Click OK and after that, you may get another calculation warning regarding obsolete processes. 

Click Continue and select ‘’show indicator as percentage’’. You will then see the network diagram 

as seen in Figure 4.10. You can play around with different cut-off percentages to 

increase/decrease the number of nodes shown in this diagram. 

 

 

Figure 4.10 Network diagram of aluminium frame bike life cycle 

 

From Figure 4.10 we can see that transport using a passenger car (i.e., transportation involved for 

the bike maintenance) causes 53.9% of the total impact caused during the entire life cycle of the 

bike using aluminium frame. The bike assembling causes about 46.1% of the impact, with its 

main source of impact (13.3%) coming from the Pair of wheels assembly.  

 

By clicking on the Tree tab, you will see the tree view as in Figure 4.11. 
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Figure 4.11 Tree diagram of aluminium frame bike life cycle 

 

From Figure 4.10 and Figure 4.11, it is clear that transport in a passenger car (i.e., transportation 

involved for the bike maintenance) has a larger impact during the entire life cycle of the bike 

compared to the total impact of production and assembly of the bike with aluminium frame. 

Show input and output flows: This option shows the input and output flows according to the 

corresponding node you select. 

Show analysis groups: This option allows you to view the results grouped by its functions (for 

example, production, energy, transport, waste) rather than the standard view per process or 

product stage. To learn more about this option please refer to this video on the SimaPro Help 

Center.  

 

Tree cannot be shown and not all products are visible 

When you choose to display your calculation in Tree mode, you may get a warning that it is not 

possible to display it as a tree because it contains loops. This simply means that you might 

accidentally choose ecoinvent unit processes in your model and it is only possible to view loops in 

the Network view. You can go through your model again and make sure that you choose system 

process data, and not the unit process. 

Furthermore, it is also possible to see the warning stating that not all products of your network 

are currently visible. This simply tells you that not all nodes are displayed in the Network/Tree as 

there are too many to fit the screen to keep it legible. It calculates a cut-off level in such a way 

https://support.simapro.com/s/article/Using-Analysis-of-Groups-in-SimaPro
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that only some of the most important procesess are displayed. You can play with the cut-off 

percentage to explore and view more processes. 

 

4.7.2 Analysis diagram 
To see the environmental impacts of the life cycle of the bike, click on the Bike life cycle 

(Aluminium frame) (under the Product stages > Life cycle > Others) and select the Analyze icon at 

the toolbar. Select ReCiPe 2016 Endpoint (H) with World (2010) H/A Normalization/Weighting set 

as the impact assessment method and click on the Single score tab. You will see a window as in 

Figure 4.12. 

 

Figure 4.12 Analysis of environmental impacts over the entire bike life cycle using aluminium frame 

 

Try exploring other tabs and options (as we discussed in Chapter 3) to get a more detailed 

analysis of the results. 

 

4.8 Comparison of bike life cycle using different frames 
Once you finish entering all the bike life cycle details for the different frames it would be 

interesting to compare their impacts. Select all these life cycle models from top to bottom (by 

clicking while holding down the CTRL key) and click on Compare icon at the toolbar. Select ReCiPe 

2016 Endpoint (H) with World (2010) H/A Normalization/Weighting set impact assessment 

method and then click Calculate. Go to the Single score tab and you should the following window 

as seen in Figure 4.13 (provided you entered all the details correctly). 
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Figure 4.13 Environmental impacts over the entire bike life cycle using different frames 

 

Figure 4.13 shows that using bikes with aluminium or steel frame will have a lower impact over its 

life cycle when compared to using bikes with carbon fiber or titanium frames.  

You can also explore other different tabs and options (which we discussed in the previous 

chapter) to get a more clear and detailed analysis of these results. 
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5  A parameterized bike 
model 
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5 A parameterized bike model 
What you will do Perform a sensitivity analysis for the bike model using parameters 

Required Entry level Chapter 2, 3 and 4 should be completed first (including the 

exercises) 

Recommended reading ‘Introduction to LCA with SimaPro’ Chapters 1, 2, 3, 4 and 5 

SimaPro license type SimaPro PhD/Expert/Power 

Please note that the feature parameters with scenario analysis (the 

‘’Parameter sets’’ tab) is not available in the Classroom and Faculty 

license of SimaPro. 

 

5.1 Introduction 
While performing the Life Cycle Assessment of systems, you have to make various input data 

assumptions. This was the case with your bike model as well. Thus, you should perform a 

sensitivity analysis to obtain more robust LCA results. The sensitivity analysis allows you to 

identify the parameters which influence your results. The theory behind a sensitivity analysis is 

simple: play around with the input values and processes, recalculate the LCA results and check 

their influence on the results. You can use the Parameters in SimaPro to perform a sensitivity 

analysis, by changing the input values and processes of your model and checking the results. 

In SimaPro, parameters can be defined on the database, project or process level. Parameters will 

be discussed in detail in the next sections.  

 

Different parameter levels in SimaPro 

Parameters can be defined on three different levels in SimaPro:  

Database parameters: are parameters that are defined on the database level (under Inventory -> 

Parameters, tab Database). Once you create this parameter, you can use it in all libraries and 

projects within this SimaPro database.  

Project parameters: are parameters that have meaning only in the project you are working in. 

You can define different parameters per project (under Inventory > Parameters, tab Project). 

These parameters are independent of one another and can be under the same name while 

having a different meaning per project 

Process parameters: are parameters that refer to a process or product stage level. You can 

define process parameters in many different processes (under Inventory > Processes or Product 

stages, tab Parameters) and they all can have different meanings or purposes. 

If they have the same name, process parameters overrule project parameters, and project 

parameters overrule database parameters. 

Individual parameters can be used in formulas to form a calculated parameter. Calculated 

parameters can be specified below the parameters, so also on three levels. 
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In this tutorial, we will show you how to model the parameters on a process level (i.e., involving 

the bike model). We will analyze how the choices we made could potentially influence our results. 

Generally, the subject of this sensitivity analysis may be related to:  

• assumptions we made, for example variation in the transport distance 

• selection of library and process data, for instance using data from different regions or 

sources  

• methodological choices, for instance comparing the type of allocation used 

• selection of impact assessment methods  

 

Uncertainty analysis 

While the outcome of the LCA can depend quite heavily on the assumptions made, LCA data is, 

inevitably, full of uncertain numbers. These uncertainties can have different causes, like 

uncertain measurements or uncertainty about how representative a figure is for the actual case 

we are studying. This means we must ask ourselves how certain or uncertain our results are, 

especially when we are comparing data. Read more about how to deal with uncertainty and 

Monte Carlo analysis in this article or in the Introduction to LCA manual. Please note that 

uncertainty calculations can only be made in SimaPro PhD, Expert, and Power licenses.  

 

5.2 Variable transportation distances for bike maintenance 
In Chapter 4 section 4.7.2 we saw that the main source of impact during the entire life cycle of 

the aluminium frame bike was the transport involved for bike maintenance in a passenger car. 

Using Parameters, you can create scenarios and compare the environmental impacts for 

different distances involved during bike maintenance. In this case, we will compare the impacts 

for scenarios involving variable transportation distances for the aluminium frame bike. 

  

Preview: For the baseline scenario we assumed a transportation distance of 450 km for bike 

maintenance over its total lifetime of 15 years (from section 4.3). In this example, we will compare 

the impacts for the following distances in addition to the baseline scenario: 

 

Table 5.1 Transportation distance scenarios for maintenance for the aluminium frame bike 

Baseline scenario Scenario 1 Scenario 2 

450 km 225 km 675 km 

 

https://support.simapro.com/s/article/Behind-the-Scenes-at-Monte-Carlo-Simulations
https://pre-sustainability.com/files/2014/05/SimaPro8IntroductionToLCA.pdf
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Steps: 

1) Open the project “Tutorial” that you already created for modelling the road bike.  

2) In the inventory column on the left, select Product stages. On the right side click Product 

stages > Life cycle > Others on the right and double-click on Bike life cycle (Aluminium 

frame). 

3) Select Parameters tab at the top and create the necessary input parameters. In this case, 

we have to create the “distance” input parameter, since we are comparing the scenarios 

for variable transportation distances. 

4) As input parameter, enter “distance” and enter “450”. You can enter “km” in the comment 

field, since we are specifying the input parameter for the maintenance transportation 

distance of the aluminium frame bike which is expressed in km.  

 

After you enter these details, the window looks like Figure 5.1. 

 

 

Figure 5.1 Life cycle bike, Parameters 

 

5) Now select the Input/output tab, under Processes, select the corresponding process and 

add the parameter distance into the amount field. In this case type “distance” directly into 

the Amount field of the process Transport, passenger car, medium size, diesel, EURO 5 

{GLO}| market for transport, passenger car, medium size, diesel, EURO 5 | Cut-off, S and 

press enter. Save this entry and the window will look like Figure 5.2 after you enter these 

details. 
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Figure 5.2 Life cycle bike, Input/output, with parameters 

6) Now click on the Analyze button at the top. Select Parameter sets tab in the ensuing 

Calculation setup window.  Click on Add option below, under Parameter set on, double-

click Set 1 and rename it as “baseline: 450 km”. Next, we need to specify the value per 

scenario. In this case we are modelling the scenarios for different transportation 

distances of 225 km, 450 km (baseline scenario) and 675 km as seen above in Table 5.1. 

Thus, click on Add parameter option, select “Scan Tree” option on the right and choose 

the distance parameter 

7) Now you have to add the parameter sets for the remaining scenarios and specify the 

values per scenario. Click on Add option, rename Set 2 on the left as low: 225 km, double-

click under the low: 225 km column on the right and enter 225. Now, again click on Add 

option, rename Set 3 as high: 675 km, double-click under the high: 675 km column on the 

right and enter 675. After entering these details, the window looks like Figure 5.3. 

 

 

Figure 5.3 Calculation setup, Parameter sets, distance 

 

Saving the parameter sets 

After you define some parameters sets as scenario analysis, you can save this as a 

calculation setup for a quicker analysis in the future. To do that, go to the General tab next to the 

Parameter sets. Fill in the Name, Method, and Product. Once you are done, save the calculation 

set up by clicking File > Save or pressing CTRL + S. You can find the saved calculation set up in the 

LCA explorer screen > Impact assessment > Calculation setups.  

 

Now click on Calculate button at the bottom. You will see Figure 5.4. 
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Figure 5.4 Comparison of variable maintenance transportation distances 

 

From Figure 5.4, you can see that the environmental impact during the entire life cycle of the 

aluminium frame bike is lower when the transport distance for the maintenance is lower. The 

impact increases as the transport distance for the maintenance is higher. 

 

5.2.1 Exercise 
Similar to the example above, calculate the impacts involving these three scenarios with respect 

to different transportation distances involved for bike maintenance, for the titanium frame bike 

life cycle. See Table 5.2. 

 

Table 5.2 Transportation distance scenarios for maintenance for the titanium frame bike 

Baseline scenario Scenario 1 Scenario 2 

450 km 300 km 600 km 

 

 

5.3 Compare aluminium from different regions 
In section 3.2.3  (Chapter 3), we assumed that “Aluminium, primary, ingot {IAI Area, Western and 

Central Europe}” type in SimaPro would be used for the primary aluminium ingot material used 

in the manufacture of the aluminium frame. Using parameters, you can compare the 

environmental impacts of aluminium from other regions. 

 

Preview: For the baseline scenario we used “Aluminium, primary, ingot {IAI Area, Western and 

Central Europe}” type for the primary aluminium ingot material in the production of aluminium 

frame for the road bike. In this case, we will compare the impacts when {RoW} and {CN} type of 

aluminium primary ingot material are used. {RoW} type includes inventory data modelled for 
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production of aluminium primary ingot in Rest-of-World. {CN} type includes inventory data 

modelled for production of aluminium primary ingot in China. 

 

Steps: 

1) Open the project “Tutorial” you already created for this tutorial.  

2) In the Inventory column on the left, select Processes, on the right side double-click 

Processes > Material > Different types of bike frames and double-click Aluminium frame.  

3) Select Input/output tab in the ensuing window. Under Inputs from technosphere: 

materials/fuels add the alternative material types you want to compare with. In this case, 

add a new line, select Processes > Material > Metals > Non Ferro > Transformation and 

choose Aluminium, primary, ingot {CN}| aluminium production, primary, ingot | Cut-off, S. 

Enter “1.579” and use “kg” as a unit. This amount is entered, since 1.579 kg of primary 

aluminium ingot material was used in the production of the aluminium frame.  

4) Similarly, add the aluminium from other regions. Under inputs from technosphere: 

materials/fuels, add a new line, select Processes > Material > Metals > Non Ferro > Market 

and choose Aluminium, primary, ingot {RoW}| market for aluminium, primary, ingot | Cut-

off, S. Enter “1.579 kg”. You already added the Aluminium, primary, ingot {IAI Area, Western 

and Central Europe}| market for aluminium, primary, ingot | Cut-off, S material when you 

modelled the Aluminium frame under Processes in Chapter 3. After entering these details, 

the window looks like Figure 5.5. 

 

 

Figure 5.5 Material process for aluminium frame, with aluminium from three regions 

 

5) Now, select the Parameters tab. Under Input parameters, add the parameters for the 

different types of primary aluminium ingot material you added previously. Double-click 

the line under Input parameters, enter “EU27_EFTA” and enter its value as “1” and under 

Comment enter “1=selected; 0=not selected”. Similarly, add the remaining parameters: 

Add a new line, enter “RoW”, value as “0” and under Comment enter “1=selected, 0=not 

selected”. Next, under Input parameters, add a new line, enter “CN”, value as “0” and 

under Comment enter “1=selected; 0=not selected”. The value “1” is used for the 
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“EU27_EFTA” parameter because we use this parameter as baseline for the aluminium, 

primary, ingot material. Thus, the remaining input parameters are set to “0”. 

 

 

Figure 5.6 Material process for aluminium frame, Parameters 

 

6) Now select the Input/output tab. Multiply the “Amount” for the corresponding materials 

you added in the Input/output tab (in Step 3) by the respective input parameters you 

created in the previous step. In this case, under the Amount field for Aluminium, primary, 

ingot {CN}| aluminium production, primary, ingot | Cut-off, S, enter “1.579*CN” and press 

Enter key. The “=0” value automatically appears to its right.  

7) Now, do this for the remaining materials. Under the Amount field for Aluminium, primary, 

ingot {RoW}| market for aluminium, primary, ingot | Cut-off, S, enter “1.579*RoW” and 

press Enter key. The “=0” automatically appears to its right. Similarly, under the Amount 

field for Aluminium, primary, ingot {IAI Area, Western and Central Europe}| market for 

aluminium, primary, ingot | Cut-off, S, enter “1.579* EU27_EFTA” and press Enter key. The 

“=1.58” value automatically appears to its right.  

 

After you enter the details, click Save. The window will look like Figure 5.7. 
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Figure 5.7 Material process for aluminium frame, with aluminium from three regions, parameterized 

amounts 

 

Tips for adding and moving your entry in SimaPro 

There are several ways to move your entry up and down in SimaPro. You can click Add line 

to add a new entry at the bottom of the list, just above the Add line button, and then drag it to 

the preferred position. Alternatively, you can right click on the desired position and choose Insert 

line, which will add a new line directly above. 

 

8) Now click on the Analyze button at the top. Select the Parameter sets tab in the 

calculation setup window. Now add the number of scenarios you want to model 

according to the input parameters you created in the previous step and name them. Click 

on Add parameter option below, select Scan Tree option on the right and choose all three 

input parameters (Single-click the first parameter, hold Shift key and press down arrow 

key) and click Select on the right side. Now you will see all the parameters appear on the 

right. Click Add to add the parameter sets and specify the values per scenario. To do that, 

under Parameter set on the left, double-click Set 1 and rename it as “CN”. Now add the 

remaining parameter sets by clicking on Add button twice and rename Set 2 and Set 3 as 

“EU27_EFTA” and “RoW” respectively. The names were chosen according to the type of 

primary aluminium ingot material you chose with respect to their regions.  

9) Now, enter the values for the parameters: For the “CN” parameter, enter the value “1” and 

the remaining parameters as “0”. Do this for the remaining parameters as well. For the 

“EU27_EFTA” parameter, enter the value “1” and the remaining parameters as “0”. For the 

“ROW” parameter, enter the value “1” and the remaining parameters as “0”. The 

parameter sets should look similar to Figure 5.8. 
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Figure 5.8 Calculation setup, Parameter sets, region 

 

Now click on the Calculate button at the bottom and select the Show chart icon with Impact 

assessment and Single score selected. You will see a window similar to Figure 5.9. 

 

 

Figure 5.9 Comparison of aluminium frame assembly impacts for different types of aluminium material 

used its production 

 

From Figure 5.9, you can see how the environmental impact changes, if the aluminium for the 

frame is produced in a different region. Aluminium manufactured in China and Rest-of-world 

(RoW) has a much higher impact than the aluminium produced in Europe (EU27_EFTA). 

 

Please take the time to explore the differences between the two processes with the highest 

impact. This is best done in a separate calculation. Select those two processes (Aluminium, 

primary, ingot {CN}| production and Aluminium, primary, ingot {RoW}| market for) in the LCA 

explorer and click the compare button. Switching from Single score to characterization already 

reveals differences per impact category (Figure 5.10) while their single score is almost identical. 
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Figure 5.10 Comparing Aluminium, primary, ingot {CN}| production and Aluminium, primary, ingot {RoW}| 

market for 

 

For further analysis you might want to use the unit processes rather than the system processes. 

 

5.3.1 Exercise 
For the PAN carbon fiber frame process you modelled in Chapter 3 (Exercise 3.3) (baseline 

scenario), you used a global average dataset for the electricity production (Electricity low voltage 

{GLO}) for the “Fiber production step” process. Compare the environmental impacts when 

different electricity mixes Electricity, low voltage {NL}| market for electricity, low voltage | Cut-off, 

S and Electricity, low voltage {RER}| market group for electricity, low voltage | Cut-off, S are used 

in the “Fiber production step” process involved in the PAN carbon fiber frame process. 

 

5.4 Different modes of transportation depending on distance 
In the current (baseline) scenario, we assumed that the bikes are transported over a distance of 

500 km in a 3.5-7.5 metric ton lorry from the manufacturing plant to the user location in the 

Netherlands. Now, we will calculate environmental impacts of scenarios with different modes of 

transport. 

Preview: We are comparing the environmental impacts of the different modes of transportation 

for the steel frame bike life cycle model. As mentioned above, for the baseline scenario we 

assumed a transportation distance of 500 km from the manufacturing plant to final use location 

in a in a 3.5-7.5 metric ton EURO5 lorry (from section 3.1.1).  

  

The modes of transport used for various transport distances are listed below in Table 5.3. 

 

Table 5.3 Modes of transport used for various transport distances of the steel frame bike 

Scenario Condition for distance Transport mode 
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Local (100 km) Smaller or equal to 150 

km  

Light commercial vehicle {RER} 

Regional (500 km) Between 150 and 600 km Lorry 3.5-7.5 metric ton, EURO5 {RER} 

Abroad (1500 km) Bigger or equal to 600 km Container ship, freight sea {GLO} 

 

You can use this “condition for distance” feature, if you want to compare the impacts of different 

modes of transport used when the transport distance varies. For the exercise we will model the 

following scenarios: 

• If transportation distance (local) is less than or equal to 150 km, a light commercial 

vehicle {RER} will be used for transporting the steel frame bike from the manufacturing 

plant to the use location. 

• If the transportation distance (regional) is between 150 and 600 km, a 3.5-7.5 metric ton 

euro5 lorry {RER} will be used. 

• If the transportation distance (abroad) is greater than or equal to 600 km, a container 

ship, freight sea {GLO} will be used. 

To model and compare the impacts of the transport scenarios, follow the steps below: 

 

Steps: 

1) In the inventory column on the left, select Product stages. On the right side double-click 

Product stages > Life cycle > Others on the right and double-click Bike life cycle (Steel 

frame).  

2) Select the Input/output tab in the ensuing window. Under Processes, insert a new line 

and add the alternative modes of transportation (see Table 5.3). Add a new line and select 

Processes > Transport > Road > Market and add “Transport, freight, light commercial 

vehicle {RER}| market group for transport, freight, light commercial vehicle | Cut-off, S” 

with 5292.5 kgkm. This value is entered, since that is the baseline amount calculated to 

transport the steel frame bike from the manufacturing plant to the use location. 

3) Similarly, add the remaining modes of transportation. Add a new line, select Processes > 

Transport > Water > Market and add Transport, freight, sea, container ship {GLO}| 

market for transport, freight, sea, container ship | Cut-off, S, 5292.5 kgkm. The Transport, 

freight, lorry 3.5-7.5 metric ton, EURO5 {RER}| market for transport, freight, lorry 3.5-7.5 

metric ton, EURO5 | Cut-off, S was already added when you modelled the life cycle for the 

steel frame bike. After entering these details, the window looks like Figure 5.11. 
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Figure 5.11 Life cycle bike (steel frame), Input/output, fixed amount for all 3 possible transport models 

 

4) Select the Parameters tab at the top and create the required input parameters. In this 

case, we have to create the “distance” and “mass” input parameters, since the values for 

transportation by truck are calculated by multiplying the mass of transported goods with 

the transport distance (as we saw earlier in section 4.3). 

5) Under input parameters, create the parameter “mass” and enter “10.585” as the default 

value. You can enter ‘kg’ in the comment field. 

6) Under input parameters, create the parameter “distance”, with a value of “500”. You can 

enter ‘km’ in the comment field. 

7) Under calculated parameters, add a line and create the parameter “transport”. Under 

Expression, enter mass*distance to calculate the transport needs in kgkm. The calculated 

value (5.29E3) will now be visible on the right.  

8) In the next line, enter “local” and under Expression, enter distance<=150 and press Enter. 

The “=0” value appears automatically to the right. If the statement is true, the parameter 

will return a value of “1.” In this case, the value “=0” appears since the expression used is 

not true. The specified “distance” input parameter is 500, and this is not equal to or 

smaller than 150. In the comment field, you can enter “0 if not true, 1 if true”. 

9) In the next line, enter “abroad” and under Expression, enter distance>=600 and press 

Enter. The “=0” value appears automatically to the right. The “=0” value appears since the 

expression used is not true. The specified “distance” input parameter is 500, and this is 

not equal to or larger than 600. In the comment field, you can enter “0 if not true, 1 if 

true” 

10) In the next line, enter “regional” and “distance>150 and distance<600.” The “=1” value 

appears automatically to the right. The “=1” value appears because the specified 

“distance” input parameter is 500, and this is indeed larger than 150 and smaller than 

600. In the comment field, you can enter “0 if not true, 1 if true”. 

After you have entered all these details, the window looks like Figure 5.12. 
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Figure 5.12 Life cycle bike (steel frame), parameters: input parameters and calculated parameters 

 

11) Then select the Input/output tab. Multiply the amount for the corresponding processes 

you added in the input/output tab by the input parameters you have created in the 

previous steps. In this case, under the Amount field for “Transport, freight, light 

commercial vehicle {RER}| market group for transport, freight, light commercial vehicle | 

Cut-off, S”, write “transport*local”. The “=0” value automatically appears to its right.  

12) Do this for the remaining processes. In the amount field for Transport, freight, sea, 

container ship {GLO}| market for transport, freight, sea, container ship | Cut-off, S, write 

“transport*abroad”. Similarly in the amount field for Transport, freight, lorry 3.5-7.5 

metric ton, euro5 {RER}| market for transport, freight, lorry 3.5-7.5 metric ton, EURO5 | 

Cut-off, S, write “transport*regional”. Save the changes you made to the steel life cycle. 

When you finish entering all these details, click Save. You will see a window like Figure 

5.13. 

 

 

Figure 5.13 Life cycle bike (steel frame), Input/output, parameterized 

 

13) Next click on the Analyze button. Select the Parameter sets tab. Add the scenarios you 

want to model and name them. In this case we are modelling the mode-of-transportation 

scenarios for Local (100 km), Regional (500 km) and Abroad (1500 km) bike transportation 
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distances (seen above in Table 5.3). Click on the Add parameter option, select Scan Tree 

on the right and select the “distance” parameter, to create scenarios with different 

transportation distances. Click on Add and specify the values per scenario. To do that, 

under Parameter set on the left, double-click Set 1 and rename it to “Local”. Double-click 

under the “Local” column on the right and enter 100, since you have to specify a 

transportation distance of 100 km for the “Local” scenario. 

14) Now you have to add the parameter sets for the remaining scenarios and specify the 

distances. Add the “Regional” scenario with 500 km, and the “Abroad” scenario with 

1500 km. Once you have created the parameter sets, the calculation setup looks like 

Figure 5.14. 

 

 

Figure 5.14 Calculation setup, with parameter sets 

 

Click on Calculate to compare your scenarios: 

 

Figure 5.15 Comparison of impacts for different modes of transportation based on distances (single score) 

 

From Figure 5.15, you can see the combined influence of different modes of transportation and 

distances on the life cycle impact of the steel frame bike. The difference in ReCiPe Pt between the 

three scenarios is very little in this case. The lower distance in the local scenario compared to the 

regional scenario would mean lower impact, but the light commercial vehicle means more impact 

per km compared to the lorry resulting in about the same impact in the end. The same goes for 

the lorry compared to the container ship. The impact per km by truck is higher for the regional 

transportation (500 km) of the steel frame bike, while transportation by a transoceanic ship to 
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abroad location (over a three times longer distance of 1500 km) has in the end a slightly lower 

impact in comparison. 

 

5.5 Other features in Parameters 
SimaPro offers additional features for parameters. To use them, select the parameters tab. In the 

Calculated parameter section, right-click under Expression. You will see the following options: 

• Edit Expression 

• Move Parameter 

• Convert To Constants 

• Insert External Link (only available in SimaPro Power) 

• Importing scenarios from Excel (only available in SimaPro Power) 

 

Edit expression: This option allows you to correct the expression you entered and shows the 

various functions, operators and parameters you defined in SimaPro. 

 

Move parameter: This option allows you to move parameters defined in your process to the 

project or database level (under LCA Explorer menu > Inventory > Parameters). You can also 

move multiple parameters manually by selecting multiple rows using CTRL or SHIFT, copying 

them with CTRL + C, and pasting them into the desired level, using CTRL + V. 

 

Convert to constants: This option removes the formula you have entered to calculate your 

parameter and shows the result of your formula. 

 

Insert external link: This option allows you to retrieve parameters from an Excel file or the 

database. Click on “Browse” to look for a file and select the cells you would like to use in your 

model. The file will be inserted as a link. When you change a cell value in the Excel file, it will be 

automatically updated in SimaPro. If you move the Excel file from its original location, SimaPro 

will remember the last value. If you change the location of your Excel file, you can replace the 

existing link by selecting Tools > External link Manager and find and replace the existing link with 

the new link. You can also check this article for more explanation about this feature. Please note 

that this feature is only available in the SimaPro Power.  

 

Importing scenarios from Excel: In addition to the above features, you can also import the 

different scenarios you want to use for your project from Excel. You can check this article to learn 

more about this option. Please note that this feature is only available if you have a SimaPro 

Power license. 

  

https://support.simapro.com/en/articles/504560-linking-data-to-excel
https://support.simapro.com/en/articles/504561-importing-scenarios-from-excel
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6 Support and Training  
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6 Support and training 
 

We hope you enjoyed building your first model with this tutorial!  

Feel free to contact us or your local partner if you have questions about this tutorial or any 

technical questions about using SimaPro.  We suggest you also explore the SimaPro Help Center 

for more guides, FAQs and helpful tips to help you get the most out of SimaPro.  

If you are interested in developing more advanced skills, we and our global partners provide 

dedicated SimaPro trainings. Please check this page for more information.  

 

mailto:support@simapro.com
https://simapro.com/global-partner-network/
https://support.simapro.com/en/
http://www.pre-sustainability.com/training

